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RESUMO 

 
SOARES, A. J. (2007). Análise de autocorrelação em redes aplicada ao caso de acidentes 

urbanos de trânsito. Dissertação (Mestrado) – Escola de Engenharia de São Carlos, 

Universidade de São Paulo, São Carlos, 2007. 

 

O objetivo deste estudo é explorar uma metodologia para análises de autocorrelação em redes, 

utilizando um atributo de fenômenos cuja ocorrência esteja de alguma forma vinculada ou que 

seja dependente de uma rede. Para isso foram utilizados dados de acidentes de trânsito em um 

estudo de caso para a cidade de São Carlos, referentes aos anos de 2001, 2002 e 2003. Foram 

considerados inicialmente os dados totais dos acidentes e, em seguida, separados por tipos 

(atropelamentos, acidentes com danos materiais e acidentes com vítimas). A próxima etapa 

considerou os valores dos acidentes totais majorados pela UPS (Unidade Padrão de 

Severidade). A última etapa do estudo levou ainda em consideração a localização dos 

acidentes nos arcos ou interseções, que permitiu concluir que esta forma de caracterização 

espacial dos acidentes pode interferir significativamente nos resultados da análise. Outra 

conclusão relevante foi a identificação de autocorrelação espacial elevada e positiva no caso 

estudado. Finalmente a comparação com análise semelhante realizada por áreas demonstra 

vantagens para a análise por redes. 

Palavras-chave: autocorrelação em redes, planejamento urbano, acidentes de trânsito, 

estatística espacial. 
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ABSTRACT 

 
SOARES, A. J. Network autocorrelation analysis applied to the case of urban traffic 

accidents. Dissertation (Master) – São Carlos School of Engineering, University of São 

Paulo, São Carlos, 2007. 

 

The objective of this study is to explore a methodology for network spatial autocorrelation 

analysis by applying it to an attribute of phenomena that are somehow connected to or 

dependent of a network. In other to do so, traffic accident data recorded in the years 2001, 

2002, and 2003 in the city of São Carlos were selected for a case study. A first analysis 

considered all data, followed by analyses per accident type. In another phase of the study, the 

total accidents were weighted according to their severity. The last part of the study included in 

the analysis information about the location of each accident, either at a link or at an 

intersection. A conclusion drawn from the later analysis indicated that the consideration of the 

accidents locations can produce significant changes in the results. Another relevant 

conclusion was the identification of high and positive spatial autocorrelation in the case 

studied. Finally, the comparison with a similar analysis carried out with areas shows 

advantages for the network analysis. 

 

Key works: network, autocorrelation analysis, urban planning, traffic accidents, spatial 

statistics. 
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CAPITULO 1  

INTRODUÇÃO 

Neste capítulo é feita, de forma sucinta, a caracterização do problema estudado, 

naquilo que diz respeito à estreita relação entre problemas urbanos e os transportes. Além 

disso, são apresentados a justificativa, o objetivo e a estrutura desse trabalho. 

1.1 CARACTERIZAÇÃO DO PROBLEMA 

A modernização das cidades tem trazido uma melhoria na vida da população 

urbana, embora as conseqüências negativas pesem consideravelmente. Muitas vezes os 

resultados positivos não se mostram tão marcantes como os efeitos negativos, já que estes 

últimos são muito mais incômodos e evidentes. 

Com a modernização dos transportes no último século, e mais especificamente 

no transporte urbano, as cidades conheceram uma facilidade no ir e vir de pessoas e 

mercadorias sem precedentes. Em pouco mais de 100 anos, as mudanças foram rápidas e 

significativas, de tal forma que não se encontra nada parecido na história do Homem. 

Em todo tipo de transformação, os efeitos negativos nem sempre são 

considerados e tratados de maneira a extingui-los ou ao menos minimizá-los. O trânsito é um 

claro exemplo deste fato. Não existem soluções imediatas e defintivas para resolver um dos

maiores problemas da vida moderna, entretanto é necessário que medidas preventivas e

corretivas sejam estudadas e aplicadas, pois a situação em algumas cidades é muito grave.  

Muitas hipóteses podem explicar a situação atual nas cidades. Uma delas diz 

respeito a um aumento significativo na frota de veículos automotores em todo o mundo 

observado nos últimos anos. O grande número de veículos tem gerado inúmeros problemas 
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urbanos, tais como: congestionamentos, poluição ambiental e acidentes de trânsito. De todos 

os problemas gerados é bem provável que os acidentes de trânsito seja o de maior dificuldade 

em solucionar e com o maior custo para a sociedade, pois resultam em prejuízos econômicos 

e sociais, inclusive mortes. 

1.2  JUSTIFICATIVA 

Em geral, aumentos na frota representam maior probabilidade de ocorrência de 

acidentes viários. Uma das formas de reduzir esse risco de aumento no número de acidentes é 

buscar soluções para tornar a rede viária mais segura. Para isso, é necessário saber onde e 

porque os acidentes ocorrem. Mais do que isso, é preciso conhecer detalhes da distribuição 

espacial dos acidentes na cidade e, sobretudo, na rede viária. 

Uma maneira de caracterizar e compreender o problema pode ser através de 

técnicas de análise espacial, identificando padrões e, a partir desses, intervindo nos locais 

exatos da rede que eventualmente levarão a uma redução na quantidade e gravidade dos 

acidentes. Dentre as diversas formas de analisar problemas relacionados à cidade, uma 

maneira supostamente eficiente é caracterizá-la como uma rede, em que o traçado das ruas 

coincida com os segmentos que formam esta rede. A partir da caracterização da cidade como 

rede será possível aplicar técnicas de análise espacial. 

Entre as possíveis técnicas para análise espacial de redes, a autocorrelação de 

redes constitui-se em uma medida quantitativa que resume algumas das características 

relacionadas à conectividade. Seu cálculo pode ter aplicação direta a problemas de transportes 

com forte vinculação a uma rede, como é o caso dos acidentes de trânsito. 

O Índice de Moran, sendo um índice de autocorrelação espacial, pode ser aplicado 

para qualquer variável. Neste estudo, utilizou-se o número de acidentes de trânsito, mas essa 
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variável pode ser substituída por outra variável que ocorra em rede e seja passível de 

representação espacial, o que o torna muito flexível enquanto ferramenta. 

1.3 OBJETIVOS 

O objetivo principal deste trabalho é desenvolver uma metodologia de análise 

de autocorrelação em redes através do Índice I de Moran para atributos ou eventos que 

ocorram essencialmente em redes e sejam passíveis de representação espacial. Por meio da 

metodologia pretende-se analisar mais especificamente, em um estudo de caso, a rede viária 

da cidade de São Carlos e a ocorrência dos acidentes de trânsito em um período de três anos 

(2001, 2002 e 2003). 

1.4 ESTRUTURA DO TRABALHO 

Este trabalho foi estruturado a partir de uma revisão bibliográfica referente a 

conceitos de Conectividade através de diferentes formas de análise de rede, conforme 

discutido no capítulo 2. Em seguida, no capítulo 3, o assunto abordado serão os acidentes de 

trânsito, mostrando um panorama dos acidentes. 

No capítulo 4 é apresentado o método desenvolvido nesta pesquisa, em que são 

descritas as etapas de tratamento e formatação dos dados, bem como os procedimentos de 

análise e avaliação dos resultados, seja de forma isolada, seja quando comparados com outras 

estratégias de análise. 

Os resultados e suas análises obtidos por meio da aplicação do método 

proposto são apresentados no capítulo 5. O capítulo 6 apresenta as conclusões e 

recomendações e é seguido pelas referências bibliográficas e por um Apêndice com uma 

descrição detalhada da aplicação do método utilizando-se o software TransCAD. 
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CAPITULO 2  

ANÁLISE EM REDES 

Este capítulo apresenta alguns conceitos baseados em uma revisão 

bibliográfica, descrevendo e demonstrando a importância do estudo das redes, especialmente 

no espaço urbano.  

A história da civilização pode ser contada pelos registros deixados nas ruas e 

construções ao longo do tempo. A evolução do homem é percebida quando este resolveu fixar 

moradia e cultivar sua própria subsistência. Até o período das grandes navegações – fenômeno de 

transportes – a vida urbana era limitada em alguns poucos quilômetros, seu raio de atuação 

cotidiana não passava de relações entre uma ou duas cidades vizinhas.  

A necessidade de locomover-se impulsionou as grandes invenções e descobertas, a 

busca de novos “mundos”, o aprimoramento de novos meios de transportes e as conseqüências 

desta busca. Talvez sem muitos exageros, essa necessidade foi e continua sendo a grande mola 

propulsora de evolução humana. Porém, o preço de todo desenvolvimento também está refletido 

nas cidades, independentemente do porte que elas tenham, em todas há congestionamentos, 

acidentes, poluição. 

As cidades, por serem o local de realização de muitas atividades humanas, 

apresentam alguns problemas crônicos, cuja solução não é simples, mas que não podem,

no entanto, ser ignorados. É necessário considerá-los e a melhor maneira de fazê-lo é ter uma 

visão ampla do todo, considerando as cidades como algo ao mesmo tempo estático e dinâmico, 

um organismo vivo. 

Os diversos fenômenos e processos observados nas cidades, bem com as múltiplas 

inter-relações entre eles, exigem o uso de diferentes conceitos para sua compreensão e estudo. 
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Alguns deles se baseiam em uma visão subjetiva, como é o caso da cognição e conceitos de 

sustentabilidade e espalhamento. 

Outros se baseiam em uma visão mais objetiva, como os índices de acessibilidade 

e conectividade. De maneira geral, no entanto, todas as abordagens buscam, de uma forma ou de 

outra, parâmetros para quantificar a percepção do cidadão quanto a sua qualidade de vida. 

2.1 SUSTENTABILIDADE, CIDADES COMPACTAS E ESPALHADAS 

Uma das referências mais conhecidas sobre sustentabilidade está em WCED 

(1987) apud Costa (2003) que define o conceito de desenvolvimento sustentável como 

“aquele que atende as necessidades da geração atual sem pôr em risco a capacidade das 

gerações futuras de atender às próprias necessidades”.  

O desenvolvimento sustentável é uma questão bastante relevante, sendo uma 

abordagem constante em pesquisas, tanto em países desenvolvidos quanto nos países em 

desenvolvimento. 

Em Maclaren (1996) apud Costa (2003), considera-se a sustentabilidade como 

um estado desejável ou um conjunto de condições que se mantém ao longo do tempo, 

portanto o desenvolvimento sustentável pode ser uma solução para o alcance do equilíbrio. 

A preocupação com a sustentabilidade também deve ser aplicada ao ambiente 

urbano, já que é nele onde se centralizam e organizam praticamente todas as atividades 

humanas, desde as mais básicas: alimentação, locomoção e abrigo; passando pelas 

manifestações culturais, pelo trabalho e estudo, finalizando nas atividades de lazer. 

As cidades contemporâneas enfrentam grandes problemas; escassez de recursos 

(naturais ou não), carência de infra-estrutura e planejamento, desigualdade social, são alguns 

dos conflitos gerados no meio urbano. E a tendência é somente aumentar, por isso que a busca 

por soluções coerentes, efetivas e de grande abrangência se faz urgente. 
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Um aspecto fortemente relacionado ao conceito de sustentabilidade no 

ambiente urbano é o modo com que as redes de vias e os contornos das cidades são formados. 

A configuração da rede de vias pode ser fator importante em políticas públicas, determinando 

inclusive se a aplicação de recursos é ou não eficiente. 

Newman e Kenworthy (1988) apresentaram como estratégias para economizar 

energia através de uma melhor utilização do solo urbano, o adensamento, a centralização e 

políticas de restrição de tráfego, incluindo melhorias no transporte público. Outros autores, 

Gordon e Wong (1985) e Gordon e Richardson (1989) rejeitaram as estratégias de 

centralização, defendendo padrões urbanos multinucleados como mais econômicos e a única 

estratégia de desenvolvimento capaz de satisfazer as preferências dos moradores por 

habitações em regiões de baixa densidade populacional. Os trabalhos de Newman, 1992; 

Gordon e Richardson, 1997; Ewing, 1997; Kenworthy e Laube, 1999 e Talen, 2001, também 

debatem o assunto mostrando a preocupação com o tema. 

Uma questão de sustentabilidade bastante relevante é a organização do tecido 

urbano. Apesar de haver diversos modelos urbanos, este estudo tratará apenas das cidades 

com padrão europeu ou americano, por causa da configuração da rede de vias. 

As cidades européias são compactas, muitas vezes mononucleadas, com um 

traçado peculiar, algumas com mais de 500 anos de história, o que se reflete no desenho de 

suas ruas. Com vias sinuosas, às vezes por causa de acidentes geográficos, as habitações 

concentram-se nos centros, são bem adensadas, e as pessoas necessitam caminhar pequenas 

distâncias para atingir seus objetivos. Na maioria delas o transporte público é privilegiado, 

visto que as ruas são estreitas e não comportam muitos veículos. O que a princípio era uma 

solução meramente espacial, tornou-se vital para as cidades européias, já que atualmente elas 

funcionam graças ao transporte público eficiente, caso contrário já teriam entrado em colapso. 
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As cidades americanas retratam uma sociedade do consumo, que privilegia o 

bem maior, o automóvel; apesar de algumas já demonstrarem uma mudança no pensamento 

quanto ao uso do veículo particular, a maioria delas é espalhada, com grandes avenidas, ruas e 

viadutos; configurando uma paisagem urbana onde para deslocar-se é necessário o veículo. 

Apesar de possuir uma boa infra-estrutura de ruas e avenidas, o transporte público não recebe 

incentivo, inclusive por questões culturais. O veículo particular ainda é o grande agente 

urbano. 

Muitos pesquisadores ressaltam os benefícios da forma das cidades compactas, 

como a redução das necessidades por transportes e as menores taxas de emissão de poluentes, 

uma utilização mais eficiente da infra-estrutura urbana, a preservação de áreas agrícolas e as 

diversidades sociais e culturais. Por outro lado, há a poluição, perda da qualidade urbana e 

redução de espaços abertos como contra-argumentos. 

A grande crítica que se faz às cidades espalhadas é que são projetadas 

para o automóvel e não para o pedestre. Ao promover o espalhamento, grande parte dos 

recursos físicos e financeiros é gasta em infra-estrutura viária; cidades como Los Angeles, por 

exemplo, apresentam cerca de dois terços do espaço urbano ocupados com ruas, avenidas e 

viadutos. Além dos elevados custos operacionais, construção, manutenção e recuperação das 

vias e segurança viária, há também gastos energéticos (combustíveis) e de deslocamentos. 

Outro ponto é o isolamento das pessoas e a perda de identidade e da coletividade. 

Uma avaliação superficial de estudos sobre o assunto mostra que as melhores 

alternativas de crescimento urbano estão divididas entre: cidades mais compactas, com um 

centro ativo e transporte público de boa qualidade, e cidades multinucleadas, teoricamente 

capazes de servir ao automóvel e fornecer uma opção de transporte àqueles que não podem 

dirigir. Apesar das divergências nos pontos de vista dos pesquisadores, alguns países já estão 

adotando políticas urbanas para encorajar maiores densidades, baseadas em teorias de 
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sustentabilidade das cidades compactas. Estes são os casos da Austrália e de alguns países da 

Europa (NEWMAN, 1992; KENWORTHY e LAUBE, 1999). 

Esta visão, no entanto, aborda a cidade e sua rede viária de forma global, sem 

atentar para aspectos microscópicos da rede, ao qual estão diretamente relacionadas questões 

importantes, tais como acessibilidade, a cognição e a conectividade. 

2.2 ACESSIBILIDADE 

Há muitas definições para o termo Acessibilidade; em Bruton (1979) apud 

Lima (1998), índices de acessibilidade “medem a facilidade com que uma área, com certas 

atividades atraentes, pode ser alcançada a partir de uma zona particular e através de um 

determinado sistema de transportes”. Já Ingram (1971) diz que acessibilidade é “a 

característica de um determinado local com respeito a alguma forma de fricção (alguma 

medida de tempo ou distância)”. 

Lima (1998) apresenta como uma definição de acessibilidade bastante 

freqüente na literatura “a medida de esforço para se transpor uma separação espacial 

caracterizada pelas oportunidades apresentadas ao indivíduo ou grupo de indivíduos para 

que possam exercer suas atividades, tomando parte do sistema de transportes”. 

Índices de acessibilidade são bons indicadores para avaliar a qualidade do 

sistema de transporte de uma cidade. Por isso, no planejamento de transportes, a busca por 

bons índices deve ser constante, já que a avaliação leva em conta tanto às características do 

uso do solo quanto a qualidade do sistema de transportes. 

Haggett e Chorley (1969) introduzem outros conceitos: 

• Acessibilidade relativa: é definida como o grau com que dois lugares ou 

pontos de uma mesma superfície estão conectados. Entretanto, a relação 

entre os pontos não é necessariamente de igual intensidade. Um 
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exemplo desta característica é a assimetria de distâncias entre lugares 

locados numa rede de ruas de sentido único. 

• Acessibilidade integral: é definida como o grau de interconexão de um 

ponto com os outros pontos da superfície, ou seja, a relação de cada 

ponto com todos os demais outros pontos. 

Os índices de acessibilidade também podem ser reflexos da forma urbana, 

porque além da questão da atratividade, altos índices indicam que a cidade ou região 

apresenta um tecido urbano bem articulado, com pequenas distâncias médias entre os pontos 

resultando numa boa mobilidade. O tema acessibilidade foi exaustivamente tratado na 

literatura, como pode ser visto em Silva (1998) e Raia Jr. (2000). 

2.3 COGNIÇÃO 

A busca pela exploração da estrutura das redes viárias, a acessibilidade, a 

conectividade e a eventual influência na sustentabilidade do espaço construído resultam em 

uma percepção ambiental muito particular do cidadão. Muitos pesquisadores têm trabalhado a 

respeito, os autores Thorndyke e Hayes-Roth (1982) propõem modelos de conhecimento 

espacial em que são testados os níveis de percepção dos cidadãos, tanto através de mapas 

quanto de rotas de navegação. Estes testes mostram como o cidadão percebe e capta a imagem 

da cidade, formando um conjunto de informações mentais sobre seu “espaço”, tais como sua 

identidade e sua relação com a cidade. 

A cidade é um conjunto de relações interpessoais com o meio ambiente natural 

e o construído, tentando encontrar o equilíbrio e a simbiose entre todos os envolvidos. 

Caliandro (1978) afirma que a vida urbana contemporânea poderia ser espelhada na forma 

aparentemente acidental de nossas cidades. Apesar de tudo, há certa regularidade ambiental 

que poderia permitir uma intenção e, conseqüentemente, um papel para as vias urbanas. Pelas 



ANÁLISE DE AUTOCORRELAÇÃO EM REDES APLICADA AO CASO DE ACIDENTES URBANOS DE TRÂNSITO 10 

análises comparativas, esta regularidade da forma e uso emerge e ajuda na formulação de 

políticas e projetos urbanos publicamente responsáveis. 

Assumindo que o traçado das ruas de uma cidade forma uma rede, é nesta em 

que ocorre uma interação das pessoas com os edifícios, com a localização e a circulação, com 

as atividades socioeconômicas e com o uso do solo. Enfim, pode-se dizer que as cidades são 

redes complexas, tanto do ponto de vista social quanto do estrutural. 

Segundo Escolano (2003) a rede de ruas da cidade contém informações sobre o 

grau de organização desta. Estas informações associadas podem ser usadas como indicadores 

da complexidade estrutural, caracterizada pelo grau da eficiência, da legibilidade, entre 

outros. Tais informações podem ser de grande valia para o planejamento urbano, já que 

compreendem elementos da estrutura urbana, como por exemplo, a circulação de veículos. 

2.4 CONECTIVIDADE 

Podem-se aplicar os conceitos de conectividade de redes em várias ciências, 

destacando a física, ciência da computação, sociologia e o planejamento urbano, mais 

precisamente no estudo de redes viárias (LYNCH, 1981; SALINGAORS, 2003). 

A topologia de rede é a forma através da qual ela se apresenta fisicamente, ou 

seja, como os nós e arcos estão dispostos. Em poucas palavras, a topologia de uma rede 

descreve como é o leiaute do meio através do qual há o tráfego de informações e também 

como os dispositivos estão conectados a ele. 

Alguns elementos da rede recebem diferentes nomes conforme a ciência que os 

emprega. Newman (2003) apresenta algumas definições e nomes correlatos: 

• Vértice (matemática), site (física), nó (ciência da computação) ou ator 

(sociologia): unidade fundamental da rede; 
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• Edge, laço/bond (física), elo/link (ciência da computação) ou laço/tie 

(sociologia): linha que conecta dois vértices; 

• Orientado, não-orientado: um grafo é orientado se todos os links são 

orientados e um grafo é não–orientado quando tem dois links entre cada 

par de vértices conectados, um em cada sentido. Link orientado às vezes 

é chamado de arco. 

As redes são topologicamente representadas como grafos, onde um grafo G 

compreende uma série de vértices ou nós V (intersecções e finais de ruas) e segmentos de ruas 

E conectadas a aqueles vértices (HAGGET e CHORLEY, 1969). Os nós são lugares onde o 

indivíduo tem que tomar a decisão sobre o movimento na cidade. São também importantes 

localizações para a construção de imagens na paisagem urbana. 

Ruas com diferentes tipologias (CALIANDRO, 1978; BEN JOSEPH e 

SOUTHWORTH, 1997) fornecem a conexão para as cidades. Para Moles e Rohmer (1990) 

apud Escolano (2003), “a rede de ruas é uma parte essencial da teoria que concebe a estrutura 

física urbana como um labirinto geométrico, talvez estético e também um labirinto de 

experiências individuais, onde o desenvolvimento social individual e em grupos revela-se em 

diversas escalas”. 

Como as concepções do espaço urbano (GOULD e WHITE, 1974) são 

afetadas pela estrutura do mesmo (LYNCH, 1960), a desconectividade tem impactos sobre a 

orientação e a qualidade de vida dos cidadãos (APPLEYARD, 1981; WHYTE, 1980; GEHL, 

1987; SOUTHWORTH e OWENS, 1993; OWENS, 1993; SOUTHWORTH e BEN JOSEPH, 

1995; SOUTHWORTH, 1997; BOSSELMANN et al., 1999). Dupuy (1991, 1995), no 

entanto, sugere que as ruas das cidades contemporâneas são dominadas pelo automóvel, 

caracterizadas pela conectividade para os carros e desconectadas para os pedestres. 

Entre as propriedades topológicas de maior interesse para este estudo, que se 

baseia em redes, caracterizando as cidades como redes complexas, estão os elementos: Small 
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World, Índice de Centralidade, Estruturas Comunitárias e Autocorrelação de Redes, 

apresentados a seguir. 

2.4.1 Small World 

A teoria do Small World surgiu dos experimentos do psicólogo Stanley 

Milgram em 1967. O experimento partiu da hipótese que qualquer indivíduo pode se 

relacionar com qualquer outro individuo no mundo inteiro, desde que sua rede possua ao 

menos seis relações de amizade com indivíduos diferentes, e estes possuam redes de amizade 

distintas. A partir deste experimento novas pesquisas em sociologia foram desenvolvidas 

incorporando os conceitos de rede. O próximo passo foi introduzir os resultados das pesquisas 

em outras áreas. Este fenômeno é aplicado em áreas de estudo como a sociologia, 

antropologia, informática, biologia, etc. 

O efeito “Small World” aplica-se, sobretudo a redes de informação e significa 

dizer que a transmissão da informação é exponencial. Por exemplo, se forem consideradas 

seis pessoas para espalhar uma informação para quaisquer outras seis pessoas e assim 

sucessivamente, então a informação se espalhará mais rápido que se forem consideradas 

centenas ou milhares de pessoas onde a transmissão da informação se dá apenas 

individualmente. Ao final, esta característica apresenta menores “distâncias de caminhada”, 

embora com muitas opções entre as origens e destinos (WATTS e STROGATZ, 1998; 

DUCKHAM e KULIK, 2003; NEWMAN, 2003; KUIPERS, 2001). 

2.4.2 Índice de Centralidade 

O Índice de Centralidade é a capacidade de identificar o grau de centralidade 

da cidade (MARCHAND, 2002), característica potencialmente posta de lado pela 
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policentralidade dos tempos modernos (BATTY, 2001). Segundo Escolano (2003), a estrutura 

das ruas dentro de uma cidade configura um sistema estático próximo ao equilíbrio, 

interagindo com o entorno com o qual mantém alguma relação (incluindo a de canalizador de 

movimentos entre os edifícios). Por isso, há a influência das ruas sobre o movimento, a 

localização das pessoas, as atividades econômicas e sobre o uso do solo. A estes, e outros 

efeitos combinados, dá-se o nome de centralidade, importante na caracterização de território.  

2.4.3 Estruturas Comunitárias 

As Estruturas Comunitárias são particularmente importantes para a 

representação mental voltada para a navegação humana, tendo em vista que essa é 

topologicamente orientada (segundo SIEGEL e WHITE, 1975; KUIPERS, 1978; 

THORNDYKE e HAYES-ROTH, 1982) e também hierárquica (STEVENS e COUPE, 1978). 

Posto de outra forma, a divisão das cidades em bairros (GIRVAN e NEWMAN, 2002, 

KUIPERS, 1978) leva à criação de uma identidade social (RAPOPORT, 1977; 

PROSHANSKY et al., 1983; UZZEL et al., 2002), que permite uma análise topológica 

relevante para a localização e orientação na navegação humana, cujo raciocínio espacial se dá 

por meio de mapas cognitivos (KUIPERS, 1978). 

2.4.4 Autocorrelação de Redes 

A Autocorrelação de redes existe sempre que uma variável exibe um padrão 

regular sobre uma rede na qual os valores de segmentos de dados sofrem influência dos valores

de uma mesma variável em outros segmentos. Pode ser vista como uma medida derivada da 

autocorrelação espacial de áreas, na qual o método utilizado decorre das inferências 

estatísticas para testar as hipóteses por meio do Índice de Moran. Dadas as características 
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predominantemente quantitativas usualmente presentes nas análises de transportes, essa 

abordagem foi aqui selecionada para aplicação e estudo. Por esse motivo, alguns dos seus 

fundamentos teóricos são comentados a seguir. 

A análise espacial é utilizada para medir áreas e relações nelas envolvidas, 

considerando e incorporando o espaço nesta análise. Segundo Lopes (2005) a análise é “o 

estudo, exploração e modelagem de processos que se expressam através da distribuição no 

espaço”. Tobler (1970) apud Lopes (2005) cita a Primeira Lei da Geografia: “todos os objetos 

no espaço estão relacionados, porém objetos mais próximos estão mais relacionados, assim a 

localização dos objetos influencia o resultado da análise”. 

A variação espacial de um fenômeno inscrito num conjunto de técnicas, 

inclusive com métodos estatísticos, resulta no que se chama Estatística Espacial. 

A Autocorrelação Espacial, um dos conceitos da Análise Espacial, é uma 

relação entre valores de algumas variáveis que influenciam outras, mantendo uma 

interdependência; e a hipótese de interdependência é testada por métodos da estatística 

formal. 

Os testes e a mensuração da interdependência requerem informações espaciais 

ou locais expressas em termos numéricos. O processo para testar as hipóteses segue a mesma 

lógica que qualquer teste estatístico (ODLAND, 1988). A autocorrelação de redes parte do 

mesmo princípio que a autocorrelação espacial, em que um fenômeno influencia seus 

vizinhos, numa relação de reciprocidade ou não. Na análise de redes, os valores são dos 

segmentos/arcos, não mais de áreas. 

Um dos índices para avaliar o nível de autocorrelação espacial de redes é o 

Índice de Moran (1947). 
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Sendo: I = Índice de Moran; 

n = número de segmentos; 

wij = fator peso, indicando se o segmento i é conectado ao segmento j (por exemplo 

igual a 1), ou não (igual a 0); 

xi = valor da variável x no segmento i ; 

xj = valor da variável x no segmento j ; 

x = valor médio das variáveis. 

 

O valor do índice varia de -1 a + 1. Valores iguais ou próximos a -1 indicam 

que há uma autocorrelação negativa, ou seja, os valores vizinhos são extremamente diferentes. 

Valores iguais ou próximos a +1 indicam que há autocorrelação positiva, ou seja, os valores 

são similares nos segmentos adjacentes. Se o valor do índice estiver próximo a zero indica 

que não há autocorrelação, nem positiva, nem negativa. 

O uso de uma abordagem de análise dos acidentes através da aplicação de 

conceitos de autocorrelação espacial em redes já foi proposta por Black e Thomas (1998), que 

analisaram a autocorrelação dos acidentes de trânsito na rede de rodovias belgas. 

No Brasil, no entanto, os trabalhos que aplicaram os conceitos de análise 

espacial para análise de acidentes, como Queiroz (2003) e Santos (2005), o fizeram a partir da 

distribuição original dos pontos ou da sua agregação em áreas. 

Tendo em vista que os dados utilizados por Santos (2005) foram 

disponibilizados para o presente estudo, todas as análises aqui propostas são realizadas 

também na cidade de São Carlos. Isso permite uma comparação direta dos resultados obtidos 

com as diferentes abordagens de análise já que, ao contrário da proposta desse estudo, Santos 

(2005) realizou somente análises de padrões pontuais e análises espaciais de áreas baseadas 

em dados de acidentes de trânsito. 
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Em síntese, o autor identificou os pontos e áreas críticas, além da distribuição 

espacial dos acidentes e identificação das tendências de deslocamento do fenômeno através de 

mapas temáticos, médias móveis e Box Map. Parte desses procedimentos foi aqui reproduzido 

a partir da análise de redes, como é detalhado na metodologia. 

2.5 CONSIDERAÇÕES FINAIS 

A revisão da literatura deixa claro que a qualidade de vida nas cidades tem 

sofrido uma deterioração lenta e silenciosa e, no intuito de frear o processo de degradação, o 

estudo do urbano é necessário e urgente. Uma das maneiras de se pensar a cidade é por uma 

visão subjetiva, como mostrada neste estudo pelo viés da cognição e pelos conceitos de 

sustentabilidade ou compacidade e espalhamento. 

Entretanto, constatou-se também a existência de visões mais objetivas, em que 

se buscam parâmetros que quantifiquem a percepção do cidadão quanto a sua qualidade de 

vida, como é o caso dos índices de acessibilidade e conectividade. Para o último, a cidade é 

tratada como uma rede complexa formada pelas ruas e avenidas. Apesar dessa complexidade, 

as cidades entendidas como redes facilitam o seu estudo, pois as informações nelas contidas 

estão organizadas e relacionadas entre si, mostrando ao mesmo tempo uma estrutura orgânica 

e bem definida. O movimento em suas ruas e avenidas pode ser comparado a um organismo 

vivo e também é um elemento organizador. 

Dentre as possíveis ferramentas aqui discutidas para análises objetivas, a 

autocorrelação de redes mostrou-se uma medida quantitativa que resume algumas das 

características relacionadas à conectividade discutidas nos itens anteriores, e foi por esse 

motivo selecionado para o presente estudo. O Índice de Moran, sendo um índice de 

autocorrelação, permite que seja aplicado para qualquer variável. Neste caso, utilizou-se o 

número de acidentes de trânsito, mas essa variável pode ser substituída por outras variáveis 
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que sejam passíveis de representação espacial, o que o torna muito flexível enquanto 

ferramenta da análise. 
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CAPITULO 3  

ACIDENTES DE TRÂNSITO 

A Organização Mundial de Saúde define acidente como “um evento 

independente do desejo do homem, causado por uma força externa, alheia, que atua 

subitamente e deixa ferimentos no corpo e na mente (...) Assim, um acidente de trânsito pode 

ser definido como um evento que envolve ao menos um veículo que circula, normalmente por 

um via para trânsito de veículo, podendo este ser motorizado ou não” (GOLD, 1998, p. 9). 

Segundo Ferraz e Raia Jr. (2007, p. 6) acidente de trânsito é “um evento 

envolvendo um ou mais veículos, motorizados ou não, em movimento por uma via, que 

provoca ferimentos em pessoas e/ou danos físicos em veículos e/ou objetos de outra natureza 

(poste, muro, casa, sinal de trânsito, propaganda, etc.)”. 

O acidente de trânsito é um dos resultados negativos do crescimento 

desordenado nos níveis de motorização em escala mundial. Dificilmente encontra-se uma 

cidade ou país que não apresente problemas relacionados a acidentes de trânsito. Mais difícil 

ainda é encontrar políticas públicas eficientes que amenizem tais problemas. O cenário nas 

principais cidades do mundo apresenta uma visão catastrófica; milhões de mortes e outros 

milhares de feridos, que em muitos casos resultam em lesões permanentes. 

Os acidentes de trânsito estão relacionados com os números da frota de 

veículos, já que o nível de desenvolvimento de um país está freqüentemente associado ao 

tamanho e qualidade de sua frota de veículos. Geralmente países em desenvolvimento, como 

o Brasil, apresentam uma frota com veículos muito velhos; falta de manutenção da frota, das 

estradas e da sinalização; fiscalização precária, sem policiamento e equipamentos adequados; 

ineficiência no atendimento médico especializado, etc. 
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No Brasil, segundo DETRAN-PR (2006), IPEA (2006) estimam-se que 

ocorram cerca de um milhão de acidentes (sendo a maioria, cerca de 62 %, urbanos), 35 mil

mortes, 500 mil feridos e 100 mil vítimas com lesões permanentes. 

Outro ponto é quanto à questão econômica dos acidentes. Os gastos com 

acidentes representam 1 % do Produto Interno Bruto (PIB) dos países pobres, 1,5 % dos 

países em desenvolvimento e 2 % dos desenvolvidos (IPEA, 2006). Essas porcentagens representam 

gastos anuais com: perdas materiais (veículos, cargas, recuperação da infra-estrutura, etc.), 

perdas com vítimas permanentes e temporárias (despesas médicas e hospitalares, tratamentos, 

reabilitações, indenizações, pensões, aposentadorias, perda de produção, funerais, etc.), outros 

custos referentes ao atendimento da polícia e paramédicos, além de danos à propriedade 

pública e privada. 

No estudo “Impacto social e econômico dos acidentes de trânsito nas rodovias 

brasileiras” realizado pelo IPEA, constatou-se que o custo de um acidente com apenas danos 

materiais corresponde a R$ 1.040,00, enquanto que em um acidente com vítima não fatal o 

valor sobe para R$ 36.305,00. Já uma vítima fatal representa um custo médio de R$ 

270.165,00 (valores em dezembro/2005 – IPEA). A Tabela 3.1 exemplifica melhor os valores. 

Tabela 3.1 – Custos por acidente de trânsito, segundo IPEA (2006) 

Condição da pessoa 
envolvida 

Custo médio associado à 
pessoa 

Custo médio adicionado ao 
acidente 

Ileso (R$) 1.040,00 1.207,00 

Ferido (R$) 36.305,00 38.256,00 

Morto (R$) 270.165,00 281.216,00 

 
Os custos econômicos só não são maiores que o custo humano e social, já que 

não se pode quantificar o sofrimento físico e emocional das vítimas e familiares, além de 

problemas futuros de natureza psicológica tanto entre vítimas quanto seus familiares. 
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Em acidentes com o transporte de cargas deve-se também computar custos 

ambientais, pois em caso de acidentes com produtos químicos podem ocorrer derramamentos 

e conseqüente contaminação de mananciais, flora e fauna. 

Ainda segundo IPEA (2006), os atropelamentos representam uma parcela 

considerável no número de acidentes, principalmente por que quase um terço dos atropelados 

morre. Outro fator de preocupação é o horário em que ocorrem, geralmente à noite, entre as 

18 e 20 horas, horário do retorno do trabalho para casa. Os acidentes com motocicletas 

guardam proporções semelhantes. Embora eles tenham representado 10,8 % de todos os 

acidentes, causaram 15,2 % de todas as mortes. 

A Tabela 3.2 apresenta o total dos acidentes com vítimas fatais e não fatais do 

Brasil e dos estados no ano de 2005, além dos números de acidentes com algum tipo de 

vítima. 

A frota de veículos aumenta a cada ano e, conforme mostrado na Figura 3.1, 

em pouco mais de 10 anos houve um aumento significativo da frota nacional. Na Figura 3.2, em 

uma primeira observação pode-se constatar que houve redução do índice de vítimas fatais por

10 mil veículos em acidentes de trânsito nos últimos onze anos, principalmente de 1996

para 1997. A explicação para esta redução é que o novo Código de Trânsito Brasileiro (CTB)

foi aprovado e entrou em vigor, o que aparentemente contribuiu para a redução, embora

não tivesse condições de resolver sozinho o problema.

A simples aprovação do CTB não garantiu que os níveis de acidentes 

diminuíssem consideravelmente, mas criou mecanismos que auxiliam a desejada redução. 

Isso reforça a importância de políticas públicas que contemplem a prevenção de acidentes e a

educação para o trânsito. 

Uma forma que auxilia na prevenção é saber como os acidentes ocorrem, quais 

locais são mais freqüentes. O número de acidentes em um local (trecho da via, cidade, estado 
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ou país) geralmente é agrupado por período, podendo ser expresso em meses ou anos. Isso é 

feito para facilitar os estudos e a incorporação dos dados em índices quantitativos. 

Para gerenciar a rede viária é desejável o mapeamento dos acidentes no 

espaço e no tempo, visando identificar onde é a maior incidência e a partir da definição traçar 

estratégias para corrigir os problemas. 

Tabela 3.2 – Total de acidentes de trânsito (DENATRAN, 2006) 

Número de Vítimas/Acidente 

 Vítimas Fatais Vítimas Não Fatais Totais Acidentes com Vítima

BRASIL 26.409 513.510 539.919 383.371
Acre 96 2.399 2.495 1.863
Alagoas 258 2.762 3.020 2.053
Amapá 105 3.083 3.188 1.599
Amazonas 332 6.124 6.456 5.274
Bahia  1.073 15.983 17.056 11.387
Ceará 1.481 11.196 12.677 9.654
Distrito Federal  442 12.408 12.850 9.359
Espírito Santo 530 13.410 13.940 10.096
Goiás 3.963 61.255 65.218 30.305
Maranhão 982 4.592 5.574 4.349
Mato Grosso 508 8.652 9.160 6.590
Mato Grosso do Sul 421 10.818 11.239 8.358
Minas Gerais 1.248 35.209 36.457 27.356
Pará 680 3.902 4.582 3.860
Paraíba 395 3.450 3.845 2.681
Paraná 1.631 52.086 53.717 38.329
Pernambuco 701 4.904 5.605 4.061
Piauí 400 3.021 3.421 2.398
Rio de Janeiro 2.584 37.749 40.333 26.507
Rio Grande do Norte 435 3.686 4.121 3.076
Rio Grande do Sul 1.153 28.592 29.745 20.745
Rondônia 326 6.446 6.772 4.704
Roraima 112 1.468 1.580 1.234
Santa Catarina 243 5.640 5.883 4.797
São Paulo 6.091 169.532 175.623 138.814
Sergipe 50 1.279 1.329 962
Tocantins 169 3.864 4.033 2.963
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Figura 3.1 – Evolução da frota de veículos ao longo dos anos (DENATRAN, 2005) 
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Figura 3.2 – Número de vítimas fatais/10 mil veículos ao longo dos anos (DENATRAN, 2005) 

 
Dentre os diversos índices existentes, o MT (2002) apresenta uma metodologia

de estudo que consiste em determinar os locais críticos, a partir de vários índices, quantificá-los

e desenvolver estratégias de combate aos acidentes. Para a determinação de locais críticos,

a metodologia apresenta a Técnica do Número de Acidentes, da Severidade de Acidentes, da 

Taxa de Acidentes e da Taxa de Severidade dos Acidentes. 
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A Técnica do Número de Acidentes considera a quantidade de ocorrências em um 

segmento da rede viária (interseção ou segmento entre interseções consecutivas) durante um 

tempo definido. Caracterizam-se como locais críticos aqueles em que o número de acidentes 

for superior à média das ocorrências registradas em cada um dos locais em análise. O método 

tem como vantagem: baixo custo de execução e praticidade; e principal utilização é a 

identificação de locais críticos – interseções e trechos com grande quantidade de acidentes

e elevados volumes de tráfego. 

A Técnica da Severidade de Acidentes considera a quantidade e a gravidade dos 

acidentes, associando a cada situação um determinado peso. Estes pesos foram estabelecidos a 

partir da relação entre os custos atribuídos a cada tipo de severidade. Além das vantagens da 

técnica anterior, o uso da severidade prioriza aqueles acidentes cujos resultados foram mais 

severos em termos de vítimas. A determinação dos locais críticos é direcionada para 

interseções e segmentos com grande número de acidentes e elevados volumes de tráfego. 

Para a sociedade, um acidente com vítima fatal (AVF) possui custo econômico 

superior a um acidente com vítima não fatal (ANF), que, possui custo superior àqueles 

somente com danos materiais (ADM). O DENATRAN instituiu a Unidade Padrão de 

Severidade – a UPS, que é o resultado da soma dos produtos do número de ocorrências por 

severidade pelo peso atribuído à respectiva severidade, conforme a Equação 3.1. Sendo 1, 4, 6 

e 13, respectivamente, os pesos atribuídos aos acidentes com danos materiais, acidentes com 

vítima não fatal, atropelamento (ATR)  e acidentes com vítima fatal. 

 

 

( ) ( ) ( ) ( )AVFATRANFADMUPS ×+×+×+×= 13641

 (3.1) 

Segundo Gold (1998), acidente com danos materiais é aquele que produz 

danos materiais, sem que destes resultem em pessoas feridas fisicamente dentre as envolvidas 
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no acidente. Já acidentes com vítimas não fatais são aqueles em que há feridos, em maior ou 

menor grau, de pelo menos uma das pessoas envolvidas. O grau pode ser leve ou grave, 

embora estes termos não estejam bem definidos. 

Atropelamentos são acidentes em que a vítima é pedestre, não estando dentro 

do veículo (motorista ou carona). Apresentam uma classificação parecida com a do acidente 

com vítima não fatal, porém na maioria dos casos, o ferimento é mais grave, mantendo uma 

relação direta com altas velocidades. Acidente com vítima fatal é o resultado da morte de pelo 

menos uma das vítimas envolvidas. 

A Técnica da Taxa de Acidentes relaciona a quantidade de acidentes de trânsito 

com o volume do tráfego em cada local. Como vantagem, tem-se a neutralização da influência 

do volume veicular no nível de acidentes, já que locais com elevados volumes de tráfego 

tendem a possuir maior número de acidentes. As taxas de acidentes são normalmente 

expressas em acidentes / milhões de veículos que entram em uma interseção ou acidentes por 

milhões de veículos x km em um trecho de via, podendo ser calculadas da forma apresentada 

nas Equações 3.2 e 3.3. 

Para interseções: 

 

( )
VP

AT
×
×

=
610

  (3.2) 

Em que: 

T = quantidade de acidentes por milhões de veículos; 

A = quantidade de acidentes na interseção; 

P = período do estudo, em dias (geralmente 365 dias); 

V = volume médio diário que entra na interseção (soma das aproximações). 

Para trechos viários: 
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( )
( )EVP

AT
××

×
=

610

 (3.3) 

Em que: 

T = acidentes por milhões de veículos/km; 

A = número de acidentes no trecho; 

P = período do estudo, em dias (geralmente 365 dias); 

V = volume médio diário que passa no trecho; 

E = extensão do trecho (em km). 

 

A Técnica da Taxa de Severidade dos Acidentes combina as duas últimas 

técnicas ao relacionar a quantidade de acidentes, expressa em UPS com o volume de tráfego, 

sendo esta taxa normalmente expressa em UPS por milhões de veículos que entram em uma 

interseção ou UPS por milhões de veículos/ km em um trecho de via. As expressões para 

cálculo dessas taxas são as Equações 3.4 e 3.5. 

Para interseções: 

 

( )
VP

deUPSnT
o

×
×

=
610

 (3.4) 

Em que: 

T = acidentes em UPS por milhões de veículos; 

UPS = unidade padrão de severidade; 

P = período do estudo, em dias (geralmente 365 dias); 

V = volume médio diário que entra na interseção (soma das aproximações). 

 

Para trechos: 



ANÁLISE DE AUTOCORRELAÇÃO EM REDES APLICADA AO CASO DE ACIDENTES URBANOS DE TRÂNSITO 26 

 

( )
( )EVP
deUPSnT

o

××
×

=
610

  (3.5) 

 

Em que: T = acidentes em UPS por milhões de veículos x km; 

UPS = unidade padrão de severidade; 

P = período do estudo, em dias (geralmente 365 dias); 

V = volume médio diário que passa no trecho; 

E = extensão do trecho (em km); 

 

Do mesmo modo que na medida anterior, a desvantagem desta medida está no 

custo para determinação dos volumes de tráfego e a vantagem em relação àquela reside no 

fato de ser considerada a severidade dos acidentes. 
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CAPITULO 4  

METODOLOGIA 

Este capítulo descreve o método adotado para o estudo da autocorrelação 

espacial em redes, referenciando aspectos da estatística espacial aplicada no presente trabalho. 

Em seguida, esses aspectos são detalhados em um estudo de caso para a cidade de São Carlos, 

apresentando a origem dos dados utilizados bem como o seu tratamento e formatação, e 

posterior análise. Nesse capítulo também estão inseridas algumas características da cidade 

referentes à distribuição dos acidentes pela rede viária. 

4.1 TÉCNICAS EMPREGADAS  

As ferramentas utilizadas neste estudo são provenientes da Estatística Espacial, 

a qual engloba, dentre outras técnicas, a Análise Exploratória de Dados Espaciais – AEDE (ou 

ESDA, da expressão em inglês Exploratory Spatial Data Analysis). Os principais elementos 

para a sua utilização são: matriz de proximidade espacial (W), vetor de desvios (Z) e vetor de 

médias ponderadas (WZ), podendo obtê-los de diversas maneiras, de acordo com o pacote 

computacional utilizado. Para análise de áreas, uma possibilidade é utilizar o software 

ArcView, com a extensão Spacestat incorporada ao programa (ANSELIN e BAO, 1997; 

ANSELIN e SMIRNOV, 1998). Já Lopes (2005), apresenta os passos para a obtenção desses 

elementos por meio do software SPRING. Outra opção é o software TransCAD, que foi aqui 

empregada e é apresentada em detalhes ao final deste trabalho, no Apêndice.  

A utilização da técnica sobre qualquer variável espacial pode ter os resultados 

visualizados através de mapas e gráficos, por exemplo, o gráfico e o mapa de Moran. 
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Qualquer que seja a maneira de visualizar os resultados, estes serão classificados em 

quadrantes, assim nomeados: Q1, Q2, Q3 e Q4. 

O uso desta técnica se justifica pelo fato de que a representação em mapas 

temáticos facilita uma comparação direta entre as diversas variáveis, o que é mais difícil 

quando os resultados são simplesmente apresentados de forma numérica. Além disso, a 

padronização dos resultados torna a informação mais clara, permitindo verificar ou não a 

semelhança entre as variáveis ao considerar relações de vizinhança entre as entidades 

espaciais. 

O diferencial desta pesquisa é caracterizar a cidade como uma estrutura em 

rede. Considerando suas ruas e avenidas como segmentos conectados entre si, a “visualização 

mental” apresenta-se muito próxima da realidade, tornando a identificação muito fácil e 

simples de se perceber. Além disso, a visualização da incorporação de novos segmentos à rede 

é facilmente captada, tanto quanto novos bairros incorporados à estrutura urbana. 

Outra questão importante é a ocorrência de eventos urbanos que têm lugar 

essencialmente em redes. Considerá-los em sua estrutura original assegura uma precisão 

maior dos dados e de quaisquer cálculos com eles realizados, já que sua estrutura incorpora-se 

ao cálculo e conseqüentemente à análise final. Como exemplo de eventos dessa natureza 

pode-se citar: a infra-estrutura urbana básica (água, esgoto, telefonia, energia elétrica, etc.), a 

coleta de lixo, o transporte público urbano e os acidentes de trânsito, que são o foco desse 

estudo. 

4.2 ESTUDO DE CASO 

Como este trabalho se propõe a realizar uma complementação do estudo de 

Santos (2005), trabalhou-se com a mesma base de dados de acidentes e no mesmo programa 

TransCAD, que é um Sistema de Informações Geográficas para Transportes – SIG-T. 
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Diferentemente de Santos, que primeiro analisou a extensão da rede sem observar a gravidade 

dos acidentes e depois analisou a gravidade sem considerar a extensão da rede; esta pesquisa 

trabalhou a rede toda incorporando os acidentes e sua gravidade, além de considerar os casos 

em arcos e interseções de forma distinta. 

Tendo em vista que as análises propostas neste trabalho baseiam-se em redes, 

foram identificados fenômenos cuja ocorrência estivesse de alguma forma vinculada ou, mais 

do que isso, fosse dependente da rede. Esse parece ser o caso dos acidentes de trânsito, 

hipótese que foi aqui testada através de um estudo de caso realizado na cidade de São Carlos, 

região central do estado de São Paulo. Com aproximadamente 218 mil habitantes, a cidade 

contava em 2006 com uma das maiores frotas de veículos automotores do estado em termos 

relativos – aproximadamente 62 mil veículos, o que representa 0,28 veículo/habitante ou 

pouco mais que um carro por família, se considerado o padrão médio de cerca de quatro 

indivíduos por família.  

No estudo de caso realizado foram utilizados os mesmos dados de acidentes de 

trânsito dos anos de 2001, 2002 e 2003, restritos à área urbana, trabalhados por Santos (2005), 

até mesmo para facilitar a comparação das metodologias trabalhadas. A Tabela 4.1 apresenta 

a distribuição dos acidentes válidos por tipo e por ano. 

Tabela 4.1 – Distribuição dos acidentes por tipo e por ano 

Anos Tipo de acidentes 
2001 2002 2003 

Atropelamentos 100 98 92 
Com danos materiais 2296 2223 2161 
Com vitimas não fatais 579 548 615 
Com vitimas fatais 2 3 4 
Totais 2.977 2.872 2.872 

 

O estudo proposto inclui as seguintes etapas: o cálculo do Índice I de Moran, a 

classificação pelos quadrantes e a análise pela visualização dos Box Map. 



ANÁLISE DE AUTOCORRELAÇÃO EM REDES APLICADA AO CASO DE ACIDENTES URBANOS DE TRÂNSITO 30 

4.2.1 Tratamento e Formatação dos Dados 

A base cartográfica da cidade de São Carlos foi obtida junto ao Departamento 

de Transportes da Escola de Engenharia de São Carlos da Universidade de São Paulo e passou 

por uma conferência para eliminar possíveis inconsistências, resultando em uma rede com 

9.786 segmentos (Figura 4.1), georreferenciada com o software TransCAD. A versão utilizada 

do programa foi a 3.6, para uso acadêmico. 

Os dados de acidentes desta pesquisa foram extraídos dos registros dos 

Boletins de Ocorrência (BOs) da Polícia Militar. Uma vez eliminados registros que continham 

inconsistências ou dados de natureza particular, tais como acidentes em locais fora da rede 

urbana ou em locais particulares (em estacionamentos privados, como no Shopping Center, 

por exemplo); os dados em que foi aplicada a metodologia foram aqueles resumidos na Tabela 

4.1. Naquela Tabela, os acidentes são separados por tipo (atropelamentos, com danos 

materiais, com vítimas não fatais e com vítimas fatais), e por ano (2001, 2002 e 2003), mas é 

possível classificá-los ainda de acordo com sua localização na rede (em arcos ou interseções). 

A Figura 4.2 mostra, a título de exemplo, a locação dos acidentes no ano de 

2001 georreferenciados e com a rede viária. Numa análise preliminar já é possível visualizar 

os locais que apresentam maiores incidências de ocorrências, com destaque para algumas 

avenidas como a São Carlos (principal eixo norte-sul), Getúlio Vargas e Miguel Petroni, 

sendo as duas últimas importantes ligações do centro com regiões periféricas. 
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Figura 4.1 – Rede viária da cidade de São Carlos em janela do programa TransCAD 

  
Figura 4.2 – Georreferenciamento dos acidentes de 2001 juntamente com a rede viária de São Carlos 

Av. Miguel Petroni 

Av. São Carlos 

Av. Getúlio Vargas 
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4.3 CONTRIBUIÇÃO DA PESQUISA 

Tendo como referência os trabalhos de Queiroz (2003) e principalmente de 

Santos (2005), esta pesquisa se propõe a complementá-los, desenvolvendo o que se poderia 

chamar de 4ª etapa, conforme mostrado na Figura 4.3. 
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Figura 4.3 – A partir da estrutura de Santos (2005) desenvolveu-se a 4ª etapa 

4.3.1 Procedimentos de análise 

Segundo a metodologia proposta, a análise dos dados tem início com a 

caracterização do grau de autocorrelação espacial, através do cálculo do índice I de Moran, 
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para cada um dos tipos de acidentes, nos três anos considerados. O procedimento passo a 

passo com o uso do software TransCAD está demonstrado no Apêndice. 

Após uma análise preliminar nos dados, calculou-se o índice através da 

Equação (4.1), uma das formas de obtenção do Índice de Moran. Na forma matricial, Z e Wz 

são vetores e Zt é o transposto de Z. 

 
ZZ

WZI t
Z

t

×
×

=

 (4.1) 

Sendo: Z é o vetor de desvios calculado com os acidentes de trânsito, sendo a diferença 

entre o valor do atributo e a média geral no conjunto de dados; 

Wz é o vetor que representa a diferença entre as médias ponderadas e a média 

geral do conjunto de dados. 

 

Terminado o cálculo dos índices, realizou-se a distribuição dos segmentos 

segundo sua classificação quanto aos quadrantes. Para isso, ainda no Transcad, foi definida a 

seguinte condição: if (Z>0 and Wz>0) then 1 else if (Z<0 and Wz<0) then 2 else if (Z<0 and 

Wz>0) then 3 else if (Z>0 and Wz<0) then 4 else 0. 

O resultado das classificações pelos quadrantes pode ser visualizado através de 

Box Maps. Nesta fase foram calculados os Totais de acidentes, Atropelamentos, Acidentes 

com danos materiais e Acidentes com vítimas para os três anos. 

Na próxima etapa, os valores Totais dos acidentes foram ponderados pela 

Unidade Padrão de Severidade – a UPS. Esta majoração é em função da gravidade que as 

pessoas estão expostas ao tráfego e do valor econômico que um acidente representa. O valor 

de um acidente com vítima fatal é muito mais grave social e financeiramente que um acidente 

com vítimas não-fatais, que por sua vez é muito mais grave que um acidente sem vítimas. 
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Os Atropelamentos também foram majorados, já que a vítima (pedestre) não 

está envolvida diretamente na ação de dirigir um veículo. Os valores (pesos) atribuídos foram: 

Acidente com danos materiais = 1, Acidente com vítima = 4, Atropelamento = 6 e com vítima 

fatal = 13. Para os valores majorados com a UPS também se calculou o índice I, a distribuição 

nos quadrantes e os Box Maps. 

Com o resultado nos primeiros cálculos, a segunda etapa serviu também para 

verificar se haveria alguma alteração significativa nos mesmos, visto que novas informações 

foram acrescentadas, pois além do número de acidentes também foi considerada sua 

gravidade.  

Na última etapa buscou-se verificar quanto a localização específica dos 

acidentes interfere nos cálculos, dado que foi observada a ocorrência de um grande número de 

acidentes em esquinas. Se um acidente acontece numa esquina, este não deve ser atribuído 

somente a um segmento, mas a todos os componentes do cruzamento, porque o acontecido, na 

maioria das vezes, é justamente em função do próprio cruzamento.  

A distribuição dos acidentes pelos segmentos nas últimas simulações ocorreu 

de duas maneiras: 

• Acidentes ocorridos no meio da quadra foram atribuídos ao segmento onde 

estavam georreferenciados; 

• Acidentes ocorridos na esquina ou próximos a ela, num raio de 10 metros, 

foram atribuídos aos segmentos constituintes do cruzamento. Em uma esquina 

formada, por exemplo, pelo encontro de quatro segmentos, o valor total de 

acidentes foi dividido por quatro e atribuído aos quatro segmentos. 

Resumindo, no total foram realizadas 18 análises. Inicialmente foram 

considerados todos os tipos de acidentes conjuntamente. Em seguida, os mesmos dados foram 

divididos em: Atropelamentos, Acidentes com danos materiais e Acidentes com vítimas não 
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fatais. Não foram feitas análises separadas com os valores de Acidentes com vítimas fatais, 

tendo em vista o reduzido número observado em relação ao Total de Acidentes: dois em 2001, 

três em 2002 e quatro em 2003. 

O conjunto total de dados foi novamente computado, com a UPS, de duas 

maneiras distintas. Na primeira delas, os dados de acidentes foram atribuídos aos arcos da 

rede de forma individualizada (ou seja, cada acidente era atribuído ao segmento da rede mais 

próximo). A diferença desse caso (e do próximo) para as primeiras análises passou a ser a 

consideração dos valores de UPS, que majoraram os valores de acidentes de acordo com a 

severidade. No último caso, cada acidente de esquina passou a contar como uma fração, 

calculada a partir do número de aproximações da interseção onde ocorreu. Assim, um 

atropelamento numa esquina com quatro aproximações resultaria em um valor de um e meio 

(um acidente com peso seis, valor do atropelamento na UPS, dividido por quatro 

aproximações). 

4.4 SÍNTESE DAS ATIVIDADES DESENVOLVIDAS 

A seguir está descrita uma síntese das etapas desenvolvidas, desde o processo 

de tratamento e formatação dos dados até a obtenção dos Box Maps e a comparação com os 

resultados de trabalhos anteriores. 

1. Obtenção dos dados de acidentes e rede viária para cada ano estudado; 

2. Tratamento e formatação dos dados; 

3. Determinação dos elementos W, Z e Wz referentes à análise dos dados com Totais de 

acidentes, Atropelamentos, Acidentes com danos materiais e Acidentes com Vítimas, 

para cada um dos três anos; 

4. Determinação dos elementos W, Z e Wz referentes à análise dos dados com Totais de 

acidentes majorados pela UPS, também para os três anos; 
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5. Determinação dos elementos W, Z e Wz referentes à análise dos dados com Totais de 

acidentes majorados pela UPS e com a localização na rede, para o período estudado; 

6. Determinação dos quadrantes a que pertencem os valores obtidos em cada uma das 

18 avaliações; 

7. Construção dos Box Maps para cada uma das análises; 

8. Análise dos resultados; 

9. Comparação dos resultados desta pesquisa com aqueles obtidos por Santos (2005). 
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CAPITULO 5  

RESULTADOS E ANÁLISES 

Este capítulo tem início com a apresentação e análise da distribuição espacial 

dos acidentes em rede, conforme metodologia apresentada na seção anterior. Em seguida, são 

apresentadas outras formas de análise da distribuição espacial do mesmo conjunto de dados, 

segunda a sua representação como pontos ou áreas, com base nos resultados obtidos por 

Santos (2005). Por fim, os resultados das distintas abordagens são, na medida do possível, 

comparados. 

5.1 DISTRIBUIÇÃO ESPACIAL DOS ACIDENTES EM REDE 

A Tabela 5.1 mostra os números de acidentes nos anos de 2001, 2002 e 2003, 

separados por tipos de acidentes e sua localização na rede. Os números mostram que os 

acidentes foram em torno de 2.900 por ano no período considerado, na sua maioria acidentes 

somente com danos materiais. Além disso, predominaram os acidentes em cruzamentos ou 

nas aproximações destes. Isto não ocorreu, no entanto, com os atropelamentos, que na sua 

maioria aconteceram nos arcos da rede e não nas esquinas, ou seja, geralmente no meio da 

quadra. 

Tabela 5.1 – Distribuição dos acidentes por tipo, por ano e por localização na rede 
2001 2002 2003 Tipos de 

acidentes Arcos Esquinas Total Arcos Esquinas Total Arcos Esquinas Total 

Atropelamentos 63 37 100 56 42 98 55 37 92
Acidentes com 
danos materiais 954 1.342 2.296 796 1.427 2.223 766 1.395 2.161

Acidentes com 
vítimas não fatais 202 377 579 168 380 548 169 446 615

Acidentes com 
vítimas fatais 1 1 2 1 2 3 1 3 4

Totais 1.220 1.757 2.977 1.021 1.851 2.872 991 1.881 2.872
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Na Tabela 5.2 são mostrados os resultados das 18 simulações realizadas, em 

que foram definidos os valores de I de Moran. 

Tabela 5.2 – Valores de I em função do ano e da classificação do tipo de dado analisado 

I de Moran Dados analisados 
2001 2002 2003 

Total de acidentes 0,15041 0,12860 0,10392 
Atropelamentos  0,02398 0,04115 0,00583 
Acidentes com danos materiais  0,15584 0,13091 0,11456 
Acidentes com vitimas não fatais  0,05357 0,05331 0,03060 
Total de acidentes com severidade (UPS) 0,12442 0,10941 0,07255 
Total com UPS em arcos e interseções 0,67049 0,70284 0,67560 

 

Outro elemento importante de avaliação foi a distribuição dos resultados por 

quadrante, cujos valores aparecem na Tabela 5.3, obtidos com as três análises que utilizaram a 

totalidade dos dados. 

Tabela 5.3 – Tabela com a distribuição do número de segmentos por quadrante 

Segmentos por Quadrante Dados analisados Ano 
Q1  Q2 Q3  Q4 

2001 565 7.029 1.647 543 
2002 583 7.089 1.590 522 

Total de acidentes 

2003 572 7.036 1.657 519 
2001 528 7.085 1.591 580 
2002 546 7.081 1.598 559 

Total de acidentes  
com severidade (UPS)

2003 555 7.096 1.597 536 
2001 1.461 7.401 738 180 
2002 1.489 7.256 866 135 

Total com UPS em 
arcos e interseções 

2003 1.495 7.256 812 158 
 

Os mapas das Figuras 5.1 a 5.18 contêm os Box Map das simulações com os 

dados totais e separados por tipo de acidente conforme apresentados nas Tabelas 5.1 e 5.2. 

Considerando que a rede viária da cidade de São Carlos é relativamente grande, cada figura 

apresenta quatro mapas para sua melhor compreensão, pois o tamanho reduzido da imagem 

poderia dificultar a apreensão do todo se os quadrantes fossem representados em único mapa 

com quatro classes. 
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Buscou-se manter o mesmo padrão em todos os resultados a fim de facilitar a 

comparação entre as caracterizações. Assim sendo, tem-se sempre no canto superior direito 

destacado os segmentos no quadrante Q1; no canto inferior esquerdo os segmentos de Q2; à 

esquerda no alto os segmentos de Q3, e à direita, na parte inferior, os segmentos de Q4. 

Nas Figuras 5.1, 5.2 e 5.3, onde aparecem representados os quadrantes do Total 

de acidentes para os três anos, percebe-se uma maior concentração de valores nos quadrantes 

Q2 e Q3, (7.029, 7.089 e 7.036 segmentos, 1.647, 1.590 e 1.657 segmentos, respectivamente), 

o que também havia sido observado na Tabela 5.3. As Figuras 5.4 a 5.12 apresentam os 

resultados por tipo de acidente. 

Nas Figuras 5.13, 5.14 e 5.15, onde o Total de acidentes foi ponderado com a 

UPS, a concentração em Q2 e Q3 também ocorre, como mostrado também na Tabela 5.3, 

mantendo a concentração de segmentos – 7.085, 7.081 e 7.096 segmentos em Q2 e 1.591,  

1.598 e 1.597 segmentos em Q3.  

Nas Figuras 5.16, 5.17 e 5.18, onde o Total de acidentes foi ponderado com a 

UPS considerando os casos em arcos e interseções de forma distinta percebe-se uma 

mudança na distribuição dos valores que, embora ainda estejam fortemente concentrados em 

Q2 (7.401, 7.256 e 7.256 segmentos), apresentam uma grande concentração em Q1, que 

passou a registrar 1.461, 1.489 e 1.495 casos. Esses valores representam a migração dos 

quadrantes Q3 e Q4 para Q1. 

O deslocamento gradual dos acidentes para regiões periféricas ao longo do 

tempo é observado nos três conjuntos de dados (Total de acidentes, Total de acidentes com 

severidade e Total com UPS em arcos e interseções) de forma semelhante, como se pode 

inferir a partir da análise das Tabelas 5.2 e 5.3, inclusive para os dados de acidentes em 

separado – Atropelamentos, Acidentes com danos materiais e Acidentes com vítimas. 
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Figura 5.1 – Box Maps com Total de acidente em 2001 
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Figura 5.2 – Box Maps com Total de acidente em 2002 
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Figura 5.3 – Box Maps com Total de acidente em 2003 
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Figura 5.4 – Box Maps com Total de atropelamento em 2001 
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Figura 5.5 – Box Maps com Total de atropelamentos em 2002 
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Figura 5.6 – Box Maps com Total de atropelamentos em 2003 
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Figura 5.7 – Box Maps com Total de acidentes com danos materiais em 2001 
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Figura 5.8 – Box Maps com Total de acidentes com danos materiais em 2002 
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Figura 5.9 – Box Maps com Total de acidentes com danos materiais em 2003 
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Figura 5.10 – Box Maps com Total de acidentes com vítimas não fatais em 2001 
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Figura 5.11 – Box Maps com Total de acidentes com vítimas não fatais em 2002 
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Figura 5.12 – Box Maps com Total de acidentes com vítimas não fatais em 2003 
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Figura 5.13 – Box Maps com Total de acidentes com UPS em 2001 
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Figura 5.14 – Box Maps com Total de acidentes com UPS em 2002 
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Figura 5.15 – Box Maps com Total de acidentes com UPS em 2003 
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Figura 5.16 – Box Maps com Total Final em 2001 
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Figura 5.17 – Box Maps com Total Final em 2002 
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Figura 5.18 – Box Maps com Total Final em 2003 
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5.2 ANÁLISE DA DISTRIBUIÇÃO ESPACIAL DOS ACIDENTES EM REDE 

Os Índices de Moran encontrados nas primeiras análises apresentaram valores 

baixos, próximos a zero, indicando ausência de autocorrelação espacial (Figuras 5.1 a 5.12). 

Isso foi verificado tanto para os Totais de acidentes como para os dados separados por tipo de 

acidente, conforme resultados apresentados na Tabela 5.2.  

As simulações com os Totais de acidentes para os três anos apresentaram 

valores de I de Moran entre 0,15 e 0,10. Já para as simulações com os acidentes separados por 

tipo, os valores foram: Acidentes com danos materiais – entre 0,15 e 0,11; Atropelamento – 

entre 0,02 e 0,005; Acidentes com vítimas – entre 0,05 e 0,03. Em uma primeira análise pode-

se dizer que a quantidade de acidentes atribuída ao segmento está diretamente relacionada 

com os resultados obtidos, visto que as simulações com maior quantidade de segmentos com 

valores diferentes de zero apresentaram maiores valores de I, como por exemplo, Total de

acidentes e Acidentes com Danos Materiais, o que poderia explicar a ausência de autocorrelação

nesses casos. 

Na próxima etapa de análise, os acidentes foram majorados pela sua severidade 

de acordo com a UPS. Considerando que os acidentes mais graves acontecem na maioria das 

vezes na periferia, a majoração poderia eventualmente equipará-los com a alta concentração 

de acidentes mais leves (danos materiais) que ocorrem na região central. Com isso esperava-

se que os resultados do índice se alterassem significativamente. 

A suposição inicial foi a de que valores altos espalhados por toda a rede iriam 

apresentar elevado valor de autocorrelação, positiva ou negativa. Contudo, embora os valores 

encontrados tenham sido diferentes das avaliações iniciais, ficaram ainda menores, não 

confirmando assim a hipótese formulada. 

Na última etapa, além da severidade, foi considerada a localização dos 

acidentes nos arcos e esquinas para a determinação da área de influência nos mesmos. Desta 
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maneira buscou-se distribuir os acidentes nos segmentos da rede de forma mais próxima da 

realidade, já que um acidente na área de influência de uma esquina não deveria ser 

considerado como pertencente a um único segmento.  

Com este procedimento reduziu-se também a grande quantidade de segmentos 

com valor zero. Apesar disto a preocupação foi a de determinar a real influência de um 

acidente em seu entorno. No caso de acidentes em esquinas, por exemplo, a análise poderia 

ser pelo padrão pontual, o que não reflete a maioria das circunstâncias que envolvem um 

acidente em cruzamentos. 

Com a mudança na distribuição dos atributos houve uma alteração significativa 

dos valores no resultado final, e esta mudança se deve à redução significativa no número de 

segmentos com valor zero. Por exemplo, enquanto o resultado de I para o Total de acidentes 

em 2001 foi 0,15041, na última análise, o valor de I foi de 0,67049, representando um 

aumento de 3,5 vezes. 

Mais importante do esse aumento, é a evidência de autocorrelação espacial. Tal 

fato se deve principalmente a redução de segmentos com valor zero, visto que nas análises 

anteriores era provável que determinados segmentos tivessem relação direta com o acidente e,

no entanto, o valor do atributo era zero. Com isso pode-se inferir que a maneira de distribuir

os valores do atributo é tão ou mais importante do que o próprio valor do atributo em si. 

A partir das simulações realizadas em três fases distintas e consecutivas traçou-

se um comparativo com o trabalho de Santos (2005), conforme proposto na metodologia. 

5.3 OUTRAS ANÁLISES DA DISTRIBUIÇÃO ESPACIAL DOS ACIDENTES 

A comparação direta dos resultados obtidos nessa pesquisa, em que os 

acidentes foram associados a uma rede, com os resultados da análise dos acidentes associados 

a pontos, ou mais detalhadamente a áreas, foi possível porque em ambos os casos os dados 
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considerados foram aqueles utilizados no trabalho de Santos (2005). Em seu trabalho, Santos 

primeiramente identificou e analisou os pontos críticos dos acidentes na área urbana. 

Trabalhando com valores absolutos, o autor pôde perceber que a maioria das ocorrências se 

dava em alguns cruzamentos da região central, com um deslocamento gradual ao longo dos 

anos em direção à periferia, mostrando uma tendência ao espalhamento pela mancha urbana. 

Uma segunda parte da análise pontual foi quanto à distribuição por ocorrência, 

em que o autor também majorou os valores absolutos pelos “índices” das UPS. Com isso, 

pode-se perceber a alta concentração na região central de acidentes leves, ou seja, acidentes 

com danos materiais, causados principalmente pelo alto volume de tráfego e velocidades 

menores; enquanto que na periferia os acidentes geralmente são mais graves, com vítimas. 

Isso pode ser explicado pelo baixo volume de tráfego e velocidades maiores. 

Em outra etapa, o autor trabalhou com áreas urbanas, fazendo um paralelo com 

os pontos críticos, utilizando para isso as mesmas delimitações dos setores censitários. Na 

análise espacial por áreas, Santos evitou a influência do tamanho da área sobre os resultados, 

optando pelos índices IAZEV e IUPSZ. 

O IAZEV – Índice de Acidentes na Zona por Extensão Viária – é dado pela 

Equação 5.1. 

 
i

i EVZ
NAZIAZEV 100×

=

 (5.1) 

Sendo:  NAZi a quantidade de acidentes ocorridos na zona i; 

EVZi a extensão da malha viária na zona i. 

 

Já o IUPSZ – Índice de Unidade Padrão de Severidade por Zona – é dado pela 

Equação 5.2. 
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i

n

ij
i

i EVZ

UPS
IUPSZ

∑
=

×
=

100

 (5.2) 

Sendo: ∑
=

n

ij
iUPS  a soma dos índices UPSi para cada área i, considerando n acidentes; 

EVZi a extensão da malha viária na zona i. 

 

Os índices encontrados são apresentados na Tabela 5.4, onde se pode perceber 

que os valores do I de Moran foram relativamente altos, principalmente para o IAZEV, 

mostrando uma autocorrelação positiva, mas com diminuição gradual ao longo dos anos 

analisados em ambos os casos. 

Tabela 5.4 – Valores de I em função dos índices IAZEV e IUPSZ  (SANTOS, 2005)

I de Moran Índices analisados
2001 2002 2003 

IAZEV 0,629 0,608 0,586
IUPSZ 0,421 0,398 0,392

 

As Figuras 5.19 a 5.20 mostram a distribuição dos índices de acidentes de 

trânsito agrupados segundo os índices considerados por Santos (2005). Em ambos os casos 

percebe-se uma concentração de valores altos na região central, enquanto a região periférica 

apresenta grandes áreas (setores) com valores baixos.  
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Em uma última etapa de analise, Santos focou naquilo que nomeou de Zonas 

de Transição. Estas zonas são identificadas a partir dos valores do Diagrama de Espalhamento 

de Moran, que podem ser representados pelos quadrantes – Q1, Q2, Q3 e Q4. Esses valores 

resultaram nas Figuras 5.21 (Box Map para IAZEV) e 5.22 (Box Map para IUPSZ), 

respectivamente.  

Ao analisar o resultado na Figura 5.21 percebe-se que as áreas no quadrante Q1 

(valor alto e média dos vizinhos alta) concentram-se na região central, ao longo do eixo 

Norte-Sul (Avenida São Carlos). O quadrante Q2 aparece em toda a periferia da cidade, 

preenchendo grandes áreas. Já Q3 e Q4 apresentam-se em menores regiões espalhadas pela 

cidade, formando quase um círculo em torno de Q1. Deve-se salientar que a interpretação dos 

Q3 e Q4 dada pelo autor está invertida em relação à interpretação dada neste trabalho, o que 

ocorre com relativa freqüência, mesmo na literatura específica da área. 

A Figura 5.22 não apresenta o mesmo padrão que a anterior, apesar dos 

quadrantes Q1 também se concentrarem na região central. Analisando espacialmente, a 

ocorrência de Q1 é equivalente tanto na Figura 5.21 quanto na 5.22, porém nos resultados de 

IUPSZ as áreas de Q1 apresentam alguns outliers (áreas “fora” da região característica). 

O quadrante Q2 mostra-se mais evidente em IUPSZ, com grandes setores. Os 

quadrantes Q3 e Q4 apresentam poucas áreas intercaladas entre os Q1 e Q2. Essa mistura 

entre os quadrantes reforça a idéia de que ao considerar a severidade das ocorrências fica 

evidente que os acidentes mais graves acontecem nas regiões das periféricas ao centro da 

cidade, onde se podem desenvolver maiores velocidades, mesmo que isso signifique 

desrespeito à regulamentação de velocidade das vias. 
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5.4 ANÁLISE COMPARATIVA DOS RESULTADOS  

A comparação dos resultados encontrados nesta pesquisa com os em Santos 

(2005) é possível porque ambos os estudos partem das mesmas premissas: o objeto de estudo 

são os acidentes de trânsito, considerados sob uma ótica de análise comum, a análise espacial, 

e com aplicação em um mesmo estudo de caso, na cidade de São Carlos. 

Em Santos (2005), os acidentes foram analisados segundo a sua representação 

pontual, ou agrupados em áreas e considerando a extensão viária e a severidade dos acidentes. 

Neste ponto há a primeira (e principal) divergência entre os dois estudos. Enquanto no 

trabalho de Santos a extensão viária e a severidade dos acidentes são consideradas 

separadamente, esta pesquisa procura associar a gravidade dos acidentes a sua representação 

direta na malha viária. 

Partindo-se da premissa de que os acidentes de trânsito ocorrem essencialmente 

sobre uma rede (viária) admite-se, portanto que são fortemente dependentes das características 

topológicas dessa rede. Assim, levando-se em consideração a composição da malha viária, 

buscou-se nesta pesquisa novas formas de cálculo para a autocorrelação espacial. O trabalho 

de Santos foi essencial nessa proposta, pois além de servir de referência teórica, permitiu uma 

comparação direta dos resultados obtidos. 

Nas primeiras avaliações, os valores de autocorrelação encontrados estavam 

muito abaixo daqueles encontrados no trabalho antecessor, o que também ocorreu na segunda 

série de simulações. A preocupação, nesse caso, não era pela diferença de valores em si, mas 

porque os resultados encontrados não mostravam qualquer tipo de autocorrelação na análise 

em rede, ao contrário do observado em padrões pontuais e de áreas. Se o fenômeno e os dados 

eram exatamente os mesmos, tal resultado era absolutamente inesperado. 

Na terceira série de simulações, em que a localização foi levada em conta de 

forma mais precisa, ou seja, acidentes nas esquinas e nos arcos foram considerados de 
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maneira diferenciada, a rede apresentou autocorrelação espacial (positiva). Além disso, os 

valores foram ligeiramente superiores aos encontrados por Santos que também mostraram 

autocorrelação espacial (positiva). Assim, o principal aspecto positivo da análise em redes 

reside no fato de assegurar a definição do local onde realmente ocorreu o acidente, além de 

considerar a severidade do mesmo. 

Numa comparação visual entre os resultados aqui apresentados de forma 

resumida, percebe-se que a análise por áreas não representa bem a realidade, na medida em 

que dificulta a interpretação dos resultados. Observando as Figuras 5.19 e 5.20 não se tem 

precisão na localização e nem na gravidade dos acidentes, dando a falsa impressão de que o 

problema localiza-se “apenas” na região central, embora algumas avenidas apresentem um 

número elevado de acidentes graves. 

Na observação das Figuras 5.21 e 5.22 para comparação da análise por áreas 

com a de redes pode-se concluir que as áreas conduzem a uma visão muito generalizada, já 

que grandes áreas podem minorar a quantidade e severidade dos acidentes. 

Nas Figuras de 5.1 a 5.18 pode-se perceber a localização exata e real dos 

segmentos com maiores problemas, auxiliando a percepção visual do mesmo, pois quando nos 

cálculos levam-se em consideração os fatores localização e gravidade a análise é mais 

adequada. 

A visualização pelos quadrantes torna-se uma maneira fácil de análise e 

comparação, visto que definido os parâmetros, a interpretação é rápida e direta, diminuindo a 

possibilidade de erros na interpretação dos resultados. 
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CAPÍTULO 6 

CONCLUSÕES E RECOMENDAÇÕES 

 

A proposta de desenvolvimento de uma metodologia de análise de 

autocorrelação em redes buscava complementar trabalhos já desenvolvidos com análises de 

padrões pontuais ou por áreas. De certa forma, isso significava uma nova maneira de tratar a 

cidade, considerando-a como uma rede (complexa) constituída por segmentos que se 

conectam entre si. 

A partir de problemas que essencialmente ocorrem em redes, que neste estudo 

são os acidentes de trânsito, se desenvolveu uma metodologia que permitiu inclusive uma 

comparação dos resultados obtidos com trabalho anterior. 

A primeira conclusão relevante desse estudo é que a forma de caracterização 

geográfica dos acidentes pode interferir significativamente nos resultados da análise. Isso foi 

evidenciado pelas diversas análises realizadas, pois apesar dos valores – quantitativos de 

acidentes – serem iguais em todas as simulações, os valores encontrados para o I de Moran 

foram muito díspares. 

Trabalhando a rede com os dados originais e com a ponderação em função da 

UPS os resultados apresentaram uma quase ausência de autocorrelação espacial. Já 

trabalhando os acidentes divididos entre os ocorridos ao longo das quadras ou nas áreas de 

influência dos cruzamentos, com sua conseqüente distribuição entre os segmentos vizinhos, 

os resultados passaram a apontar uma autocorrelação espacial positiva. 

A análise dos acidentes por sua distribuição pela localização e majoração pela 

gravidade mostrou-se mais adequada, pois integra a necessidade em precisar o local exato 

com o conhecimento do tipo de acidente a evitar, facilitando assim uma possível intervenção e 

correção. 



Por exemplo, ao trabalhar com os dados de acidentes leves (danos materiais – 

causam prejuízos menores) percebeu-se que a grande maioria dos acidentes ocorreu na região 

central, principalmente na Avenida São Carlos – principal eixo estruturador do sistema viário. 

No caso de alguma ação para correção do problema, a localização das ações seria precisa. 

Além da maneira como são caracterizados geograficamente os dados, outro 

ponto em questão foi quanto à dispersão dos pontos de acidentes na rede viária, já que ao 

longo dos três anos percebeu-se o deslocamento na quantidade e tipo dos mesmos. Levando-

se em consideração a dispersão e a geografia dos acidentes, estes apresentaram certo padrão 

ao longo do tempo. Acidentes mais leves ocorreram ao longo do eixo Norte-Sul no centro da 

cidade e suas imediações, e acidentes mais graves espalhados pelas regiões periféricas mais 

afastadas. Isto se repetiu ao longo dos três anos analisados.  

Esta pesquisa confirmou a tendência de que os acidentes estão se tornando 

mais freqüentes na periferia da cidade do que no centro, inclusive os mais graves. Este é mais 

um fator que interfere numa análise de autocorrelação, principalmente quando são 

considerados pesos para representar a severidade de acidentes. Com o crescimento do número 

e gravidade dos acidentes na periferia, que inclusive resultam em vítimas, os valores finais, 

obtidos após a ponderação pela sua gravidade, poderão se diluir na malha urbana mascarando 

os resultados, apresentando um cenário menos grave do que realmente acontece. 

Com relação ao resultado das últimas análises verificou-se que a rede viária 

apresentou autocorrelação positiva, indicando que a variação do atributo (número de 

acidentes) de um segmento é pequena em relação a seus vizinhos. Em outras palavras, os 

acidentes não são fatos isolados; um acidente interfere no segmento em que ocorre, 

influenciando os segmentos vizinhos e vice-versa. 

Esta metodologia, quando considera os acidentes de esquina e meio de quadra 

de forma diferenciada, bem como a sua gravidade, mostrou-se mais adequada que a análise de 

ANÁLISE DE AUTOCORRELAÇÃO EM REDES APLICADA AO CASO DE ACIDENTES URBANOS DE TRÂNSITO 70 



áreas conduzida por Queiroz (2003) e Santos (2005) para o problema em questão, já que o 

acidente é considerado na sua intensidade (UPS) e sua localização de forma mais próxima da 

realidade. Ainda assim, não se pode dizer que esta seja uma forma definitiva de tratamento e 

análise dos dados. Mais estudos devem ser realizados, considerando diferentes alternativas. 

Desta forma, a metodologia desenvolvida para esta análise correspondeu ao 

esperado, ou seja, permitiu demonstrar que alguns fenômenos que são intrinsecamente 

relacionados a redes (caso dos acidentes de trânsito) podem ser representados e analisados 

com ferramentas e técnicas de análise espacial, em particular, a autocorrelação espacial. 

Na busca por soluções de problemas atuais, a utilização de técnicas de análise 

espacial pode ser eficiente, principalmente neste caso em que se leva em consideração tanto a 

cidade como um todo, como a localização precisa e a gravidade dos acidentes, traçando assim 

um panorama realista e consideravelmente preciso. 

Como próximos passos, poder-se-ia pensar os acidentes também em função do 

sentido da via, sobretudo aqueles na área de influência das interseções, o que permitiria levar 

em consideração os segmentos que provavelmente interferiram de forma direta no acidente.  

Poder-se-ia também optar por estudar as interferências que o pedestre causa no sistema viário, 

ou seja, levar em conta o comportamento do pedestre, o que nesse caso pressupõe uma maior 

liberdade nos movimentos, praticamente sem restrições de sentido.  Em síntese, a solução 

adotada para considerar os acidentes em cruzamentos ainda pode e deve ser objeto de outras 

investigações, de forma a refletir de maneira mais próxima da realidade o fenômeno 

representado.  
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APÊNDICE 

A. EXEMPLOS NUMÉRICOS 

A partir da malha urbana da cidade de São Carlos e dos dados de acidentes nos 

anos de 2001, 2002 e 2003, iniciou-se a contagem do número de acidentes em cada segmento. 

Para isso procedeu-se da seguinte maneira: 

A.1 Dataview de Pontos 

Com os segmentos e os pontos de acidentes ativados (Figura A.1), sendo a de 

pontos a camada de trabalho, abre-se um Dataview conforme Figura A.2. Neste Dataview ou 

Banco de Dados, há dados referentes a cada ponto, como: ID (número identificador), latitude, 

longitude, data e endereço da ocorrência, etc. 
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Figura A.1 – Mapa dos eixos de vias de São Carlos e dos locais de acidentes 

 
Figura A.2 – Dataview de pontos 
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O próximo passo é acrescentar uma coluna a este banco de dados, com o 

comando: Dataview > Modify Table..., que faz surgir a janela da Figura A.3. 

 
Figura A.3 – Janela obtida com o comando: Dataview > Modifiy Table 

O comando Add Field permite preencher os campos Name (nome da coluna), 

Type (Real) e Width (10). As opções OK e Yes criam a nova coluna, conforme demonstrado 

na Figura A.4. 
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Figura A. 4 – Coluna criada no Dataview 

Para o preenchimento da coluna, a mesma deve ser selecionada, clicando-se 

com a opção: Edit > Fill, que abrirá a janela da Figura A.5, deve-se selecionar a opção Tag e 

preencher Using layer com a opção do nome da Layer de segmentos e Tag with com ID. 

 
Figura A.5 – Janela obtida com o comando Edit > Fill 

Com este procedimento a coluna é preenchida com os dados do Dataview de 

segmentos (Figura A.6), neste caso com o ID do segmento mais próximo ao ponto (acidente); 

assim vincula-se o ID dos pontos ao dos segmentos. 
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Terminada esta etapa, segue-se com o refinamento dos dados, em uma planilha 

eletrônica. Para isso, seleciona-se File > Save As, preenchendo o nome do arquivo e a opção 

dBASE file (*.dbf) – Figura A.7. A extensão (*.dbf) pode ser selecionada, por ser compatível 

com diversas planilhas eletrônicas.  

 
Figura A.6 – Coluna preenchida com ID dos segmentos  
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Figura A.7 – Save As 

A.2 Excel 

A razão de trabalhar no Excel é que em planilhas eletrônicas há uma maior 

flexibilidade na manipulação dos dados, como neste caso em que se necessita fazer uma 

contagem de quantos e quais tipos de acidente há em cada segmento, associando-os aos IDs 

dos pontos. 

Nesta segunda fase em que o arquivo é aberto no Excel, cabe lembrar que, o 

nome do arquivo gravado não aparecerá em Arquivos do tipo automaticamente na opção, em 

conseqüência da extensão (*.dbf). Para abrir este arquivo, seleciona-se a opção Todos os 

arquivos, seguido do nome. 

Com o arquivo aberto, a seleção de todos os dados pode ser feita clicando na 

célula superior à esquerda (1ª linha e 1ª coluna) como indicada na Figura A.8. A opção: 

Dados > Relatórios de tabela e gráfico dinâmicos, leva a seqüência de janelas mostradas na 

Figura A.9, que conduzem a uma nova planilha, conforme a Figura A.10. 
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Figura A.8 – Seleção de dados no Excel 
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Figura A.9 – Seqüência de janelas da opção Dados 

 
Figura A.10 – Janela da tabela dinâmica 

Segmento 

Tipo de 
Acidentes 

Gravidade 
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Aberta esta nova planilha; para o seu preenchimento deve-se clicar com o 

botão direito do mouse sobre o ícone escolhido na lista de campos, arrastando os selecionados 

para as áreas associadas dos quadros indicativos (em vermelho).  

Assim, o campo de linhas da nova planilha é preenchido com a coluna dos 

segmentos, lembrando que esta foi preenchida com o ID dos segmentos onde houve acidentes. 

O campo das colunas é preenchido com a classificação dos acidentes – Gravidade – neste 

caso, quatro categorias: danos materiais (1), com vítimas (4), atropelamento (6) e vítimas 

fatais (13) e os itens de dados são preenchidos com a coluna – Tipos de acidentes. Realizado o 

deslocamento dos dados para a nova planilha, automaticamente gera-se uma contagem do 

total de acidentes ocorridos em cada segmento, conforme Figura A.11. 

Em seguida selecionam-se somente os dados, excluindo as somas finais e o 

cabeçalho, conforme as indicações na Figura A.12, copiando-os e colando-os em uma nova 

planilha (Figura A.13). Além disso, a primeira coluna deve ser renomeada para ID. 
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Figura A.11 – Tabela dinâmica final 

 
Figura A.12 – Seleção dos dados para transferência 
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Figura A.13 – Nova planilha com dados extraídos da Tabela dinâmica 

A nova planilha é nomeada e salva. Entretanto, para este procedimento antes 

devem ser selecionados todos os dados, como já realizado anteriormente (Figura A.14). Para 

salvá-los, seleciona-se em Salvar como tipo a opção DBF 4 (dBASE IV), nomear e salvar – 

Figura A.15. Aparece uma nova janela questionando a incompatibilidade deste tipo de 

arquivo com os recursos do Excel, o que pode ser desconsiderado, selecionando-se a opção 

Sim – Figura A.16. A fase no Excel encerra-se com o salvamento da planilha. 
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Figura A.14 – Seleção final dos dados 

 
Figura A.15 – Opção para salvamento 

 
Figura A.16 – Janela de advertência do Excel 
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A.3 Preparação dos Dados no Transcad e criação da Matriz de Adjacência 

De volta ao Transcad, abre-se o arquivo gerado no Excel através da barra de 

ferramentas File > Open > Arquivos do tipo > Dbase file – Figura A.17. Abre-se um Dataview 

conforme a Figura A.18. Este Dataview estará preenchido com os resultados do refinamento 

dos dados no Excel, ou seja, estarão somente os IDs dos segmentos com algum acidente e 

também divididos nos quatro tipos de acidentes. 

Entretanto, percebe-se que muitas células não são preenchidas, sendo 

necessário que as mesmas sejam preenchidas, pois o programa não executa as operações de 

forma correta ignorando as células sem qualquer numeral inscrito. 

 
Figura A.17 – Opção de arquivos 
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Figura A.18 – Dataview com dados advindos do Excel 

O preenchimento das células vazias pode ser feito manualmente, ou seja, célula 

por célula. Quando se tem um Dataview com poucos dados o trabalho não é muito, contudo, 

na maioria das vezes a quantidade de dados inviabiliza um trabalho manual, por isso, é 

necessário recorrer a alguns artifícios de modo a facilitar e acelerar o preenchimento dos 

dados. Neste caso, a grande quantidade de células vazias numa coluna é multiplicada por 

quatro, já que os tipos de acidentes são divididos em quatro categorias. 

Há uma ferramenta no Transcad – Sort Dataview (indicado na Figura A.20) – 

muito útil, já que ordena os dados da coluna selecionada, facilitando a visualização dos 

resultados e identificando as células vazias. 

Para o preenchimento das células vazias é necessário o acréscimo de uma nova 

coluna, procedimento já descrito em etapas anteriores. 

Preenche-se a nova coluna selecionando na barra de ferramentas: Edit > Fill > 

Formula (Figura A.19), no campo Formula Builder há três campos com opções – Field List, 
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Operator List e Function List; no campo Field List seleciona-se a coluna F1, a opção OK e a 

coluna Cópia automaticamente será preenchida com os mesmos valores da coluna F1. 

Seleciona-se a coluna Cópia, clicando sobre o nome e em seguida no ícone Sort 

Dataview a coluna será ordenada, sendo que as células vazias ficarão no topo da coluna e os 

valores maiores no final. 

A coluna F1 estará então na mesma ordem que a coluna Cópia. O mouse pode 

ser usado para selecionar somente as células vazias (Figura A.20). Na barra de ferramenta, 

selecione Edit > Fill > Single Value e na lacuna digite o valor zero (Figura A.21), seguido de 

OK. A coluna é totalmente preenchida. Repita a operação de preenchimento com as outras 

três colunas. 

Ao final a coluna Total pode ser preenchida da maneira descrita acima ou 

selecionando-se a coluna seguida de Edit > Fill > Clear all value in the range > OK. 

Mantendo a coluna selecionada: Edit > Fill > Formula > (campo Field List) F1 + F4 + F6 + 

F13 > OK (Figura A.22). Desta maneira garante-se que a coluna estará totalmente preenchida 

e que este é o resultado da somatória dos valores das demais colunas. 
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Figura A.19 – Janela Edit > Fill > Formula 

 
Figura A.20 – Janela com a opção Sort 

 
Figura A.21 – Janela Edit > Fill > Single Value 

Sort 
Dataview 



ANÁLISE DE AUTOCORRELAÇÃO EM REDES APLICADA AO CASO DE ACIDENTES URBANOS DE TRÂNSITO 

 

96

 
Figura A.22 – Dataview com todas as células preenchidas 

Estando o Dataview dos resultados totalmente preenchido inclusive com zeros, 

o próximo passo é transferir os valores para o Dataview dos segmentos, para isso é necessário 

que uma nova coluna tenha sido criada (Figura A.23). Antes, porém é necessário utilizar a 

ferramenta Join, para assim criar os dados do preenchimento. 

O Join, como o nome diz, une Dataviews a partir de algum elemento em 

comum, neste caso, o ID. Para executar um Join é necessário que os Dataviews envolvidos 

estejam ativados. 

Com o Dataview de segmentos ativo na tela deve-se ir à barra de ferramentas 

Dataview > Join... aparecendo uma nova janela – Figura A.24. Na janela há duas abas, mas o 

preenchimento é da aba Settings. Para o Join devem-se indicar quais os Dataviews e quais 

campos serão unidos, conforme indicado na Figura A.24. 
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Percebe-se que no campo Create Joined View em Name, surge 

automaticamente um nome, que nada mais é que a junção dos dois Dataviews. Este recurso é 

um meio de conferir se a união está correta. 

Feitas as opções em Table e Field, o comando OK faz surgir um novo 

Dataview (Figura A.25), composto com as colunas dos dois Dataviews, inclusive as fixas 

(fundo verde). 

 
Figura A.23 – Janela do Dataview com nova coluna à direita 

 

Dataview 
Elemento 
comum 
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Figura A.24 – Janela da opção Joined View 

 
Figura A.25 – Janela do Dataview com Join 

Na Figura A.25 percebe-se que algumas linhas advindas do Dataview dos 

resultados estão vazias, justamente aquelas que não existiam na base de dados Resultados, ou 

seja, são os segmentos onde não houve acidentes. 

O próximo passo é transferir os dados de um Dataview para outro, lembrando 

que apesar de estarem juntos fazem parte de banco de dados diferentes e a partir do momento 

em que se desfizer a junção voltam a ter os dados originais. 

Seleciona-se a coluna que receberá os novos dados – Figura A.26 – com a 

opção: Edit > Fill > Formula, a lacuna da fórmula é preenchida com os valores da coluna do 

Dataview de resultados. As opções de preenchimento estão em Formula Builder > Field List. 

Terminada a cópia dos dados, desfaz-se o join, com a opção: Dataview > Drop 

Join... . Na nova janela que surge a Figura A.27 – clique sobre o nome do Dataview criado, 

seguido de Drop, e os Dataviews se separam. 

Coluna fixa
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Todo este procedimento levou a transferência dos dados de acidentes dos 

pontos para os segmentos, neste caso, para um único ano (2001). Como a análise se estenderá 

para os anos de 2002 e 2003, todo procedimento deve ser repetido outras duas vezes para os 

anos citados, totalizando 12 colunas de dados (fora os totais). 

 
Figura A.26 – Edit > Fill > Formula 

 
Figura A.27 – Janela do Drop Join 

A Figura A.28 mostra o Dataview de segmentos com todos os dados, onde a 

primeira coluna tem o valor Total de Acidentes nos três anos, a coluna seguinte o Total do 

Ano de 2001, a próxima o Total do Ano de 2002, depois Total de 2003, seguido pelo valor 

dos Atropelamentos em 2001, 2002 e 2003, Danos Materiais em 2001, 2002 e 2003, 
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Acidentes com Vitimas em 2001, 2002 e 2003 e Acidentes Fatais em 2001, 2002 e 2003. 

Nesta mesma Figura a linha em destaque está mostrando um exemplo: o valor 22 é a soma da 

2ª, 3ª e 4ª colunas (7 + 10 + 5), o valor 7 é a soma da 5ª + 8ª + 11ª + 14ª colunas (1 + 5 + 1 + 

0), o valor 10 é a soma da 6ª + 9ª + 12ª + 15ª colunas (1 + 9 + 0 + 0), o valor 5 é a soma da 7ª 

+ 10ª + 13ª + 16ª colunas (1 + 3 + 1 + 0). 

 
Figura A.28 – Dados dos acidentes 

A.4 Índice de Moran – via Transcad 

Com o Dataview de segmentos totalmente preenchido, o próximo passo é o 

cálculo do Índice de Moran. Este índice indica se um segmento está conectado a outro e 

quanto esta conexão interage e interfere um no outro. 

Lembrando a fórmula:  
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ZZ

WZI t
Z

t

×
×

=

 (A.1) 

Em que:  Z : atributo – média; 

Zt : Z transposto; 

Wz : matriz W x Z. 

A matriz de adjacência consiste em creditar valores à proximidade entre 

segmentos. Por exemplo, consideram-se a rede da Figura A.29 formada por segmentos de 1 a 

10 e cada segmento com um índice atribuído (valor); o segmento i =1 é vizinho do segmento 

j=2, mas não-vizinho dos segmentos j=3, j=4, j=5, j=6, j=7, j=8, j=9 e j=10; o segmento i=2 é 

vizinho do j=1 e do j=3 e não-vizinho do j=4, j=5, j=6, j=7, j=8j= 9 e j=10, e assim por diante. 

 

 

Figura A.29 – Exemplificação de Rede 

Neste caso, a matriz de adjacências é uma matriz 10x10 e os valores creditados 

são 1 para segmentos vizinhos e 0 para não-vizinhos, ou seja, na exemplificação acima, entre 

o índice 6 e 9 o valor é 1 enquanto que entre 6 e 8, 6 e 6, 6 e 5, 6 e 5, 6 e 4, 6 e 2, 6 e 2 e 6 e 3 

o valor será 0; entre 9 e 6, 9 e 8, o valor é 1, para as demais conexões é 0. 

Na rede mostrada acima o preenchimento da matriz é muito simples e rápido, 

contudo ao considerar uma cidade como uma rede, o procedimento da matriz de adjacências 

tornar-se-á impraticável seu preenchimento manualmente. Para isso, são necessários 

mecanismos que agilizem o processo. 

Índice 
atribuído 

Segmento 



ANÁLISE DE AUTOCORRELAÇÃO EM REDES APLICADA AO CASO DE ACIDENTES URBANOS DE TRÂNSITO 

 

102

O Transcad tem ferramentas que processam matrizes de adjacências, mas 

somente para analises de áreas. Para análise de segmentos, são necessários alguns 

procedimentos adicionais. 

Na janela do mapa (Figura A.30), além da camada de segmentos deve-se 

também ativar a de nós (Endpoints). Através do ícone  ou ao menu principal: Map > 

Layers pode-se obter a janela da Figura A.31, onde aparecem as duas layers, a de pontos (nós) 

e a de linhas, sendo que a primeira está escondida (Hidden) e a segunda está à mostra. Para 

“mostrá-la” clique sobre o nome da layer, em seguida em Show Layer e em Close; aparecerão 

os Endpoints (Figura A.32). Para a construção da matriz de adjacências, esta camada deve 

estar ativada. 

 
Figura A.30 – Mapa com os segmentos 
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Figura A.31 – Janela 

 
Figura A.32 – Mapa com Linhas e Pontos 

A construção da matriz está vinculada à execução de um algoritmo devido ao 

fato de o programa não executar a função para arquivos de linhas, conforme mencionado. 

Com a camada de Endpoints ativada, a opção: Tools > Add Ins... abre a janela 

da Figura A.33. Clicando em GIS Developer’s Kit seguido de OK, aparece nova janela (Figura 

A.34). O 1º ícone à esquerda abre outra janela (Figura A.35), que permite escolher um 

arquivo no diretório para compilar, clicando OK. 

O arquivo selecionado, que pode ser editado em um bloco de notas, mas que 

deve ter a extensão é *.rsc, e conter o algoritmo que processa a matriz de adjacência de linhas, 

como segue. 
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A.4.1  Algoritmo da Matriz de Adjacências 

Macro “Adja” 

fname = “Links.txt” 

fp = OpenFile(fname, “w”) 

WriteLine(fp, “Row,Column,LinkConnection") 

rh = GetFirstRecord(,) 

while rh <> null do 

  links = GetNodeLinks(rh2id(rh)) 

  for i = 1 to links.length do 

    WriteLine(fp, i2s(links[i]) + "," + i2s(links[i]) + ",1") 

    for j = i+1 to links.length do 

      WriteLine(fp, i2s(links[i]) + "," + i2s(links[j]) + ",1") 

      WriteLine(fp, i2s(links[j]) + "," + i2s(links[i]) + ",1") 

    end 

  end 

  rh = GetNextRecord(, rh,) 

end 

CloseFile(fp) 

EndMacro 

 
Figura A.33 – Janela Add ins...  

 
Figura A.34 – Janela GISDK 
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Figura A.35 – Janela Compilar 

Para testar o algoritmo, basta clicar no 2º ícone da janela da Figura A.34. Na 

nova janela (Figura A.36) seleciona-se Macro e OK. Abra o arquivo com o mesmo nome (que 

tinha a extensão *.rsc), mas agora com extensão .dbf ou .dbd. 

 
Figura A.36 – Janela Macro 

Quando se processa o algoritmo, este gera um arquivo que não se abre 

automaticamente, é necessário procurá-lo para abrir, porque durante o processamento o 

computador salvará o arquivo gerado em local que ele (computador) destina. 

O arquivo gerado consiste numa lista de dados em que consta a linha, a coluna 

com conexão direta e o valor atribuído a esta conexão, no caso igual a 1 (Row, Column, 

LinkConnection) (Figura A.37) sendo necessário transformar esta listagem em matriz. 
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Figura A.37 – Listagem gerada pelo algoritmo 

Na opção: File > New... aparece a janela da Figura A.40, selecione Matrix File, 

surge nova janela (Figura A.38), clique OK e a matriz é criada. O próximo passo é seu 

preenchimento. 

 
Figura A.38 – Janela de criação de Matriz 
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Figura A.39 – Janela de criação da Matriz 

Vá à barra de ferramenta: Matrix > Import from Dataview..., o que abre a 

janela da Figura A.39. Lembrando que a listagem gerada anteriormente apresenta dados que 

são transformados em matriz, nas lacunas Row IDs e Column IDs selecione a opção ID e em 

Data Fields, opte por Selected e Linkconnection. Dessa maneira a matriz é composta por um 

valor atribuído às conexões, ou seja, onde houver relação de vizinhança a célula 

correspondente será preenchida com o valor 1, as demais células ficarão vazias. Em seguida 

deve-se criar uma nova matriz. Através do ícone , que abre a janela da Figura A.40, 

selecione Add Matrix, seguido de OK e está criada a nova matriz (Figura A.41). 

 
Figura A.40 – Janela de preenchimento da matriz 

 
Figura A.41 – Janela de adição de matrizes 



ANÁLISE DE AUTOCORRELAÇÃO EM REDES APLICADA AO CASO DE ACIDENTES URBANOS DE TRÂNSITO 

 

108

 
Figura A.42 – Janela da nova matriz 

Esta nova matriz deve ser preenchida com valor zero, através da opção: Matrix 

> Fill, que abre a janela da Figura A.43. Preenche-se com zero a lacuna da opção Fill With, 

seguido de OK. 

 
Figura A.43 – Janela de preenchimento da matriz com valor 0 

Após o preenchimento da segunda matriz, utiliza-se o comando: Matrix > 

Quicksum para criar uma terceira matriz, preenchida com a soma das duas primeiras matrizes, 
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sendo que os valores serão zero e um. É preciso criar as duas matrizes, pois o Transcad não 

reconhece as células que não estejam ocupadas com algum numeral e como na importação 

dos dados somente os valores 1 foram trazidos, torna-se necessário completar as demais 

células. 

 
Figura A.44 – Matriz de Adjacência a partir do QuickSum 

A.5 Cálculo do Índice de Moran 

Com a matriz de adjacência preenchida, o próximo passo é a execução dos 

cálculos do Índice de Moran. Para isso é necessária a criação de outras matrizes no mesmo 

arquivo. No total serão cinco matrizes: Matriz de Adjacência, Soma_marginal, Normalizada, 

Z e Wz. 

Além das novas matrizes, são necessárias novas colunas no Dataview. Para 

cada coluna de dados (Total do ano de 2001, 2002, 2003, Atropelamentos em 2001, 2002 e 

2003, Danos Materiais em 2001, 2002 e 2003, Acidentes com Vitimas em 2001, 2002 e 2003 
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e Acidentes Fatais em 2001, 2002 e 2003) serão acrescidas outras três: Z, Wz e Quadrante. 

Nesta etapa, é conveniente acrescentar apenas uma por vez, por isso facilita os próximos 

preenchimentos.  

Primeiramente, são necessários alguns dados estatísticos, que podem ser 

obtidos com a opção: Dataview > Statistics > Save as, gerando um arquivo com extensão 

*.dbf. Embora o arquivo gerado tenha inúmeros registros estatísticos, só serão utilizadas as 

médias dos dados (5ª coluna) – Figura A.45. 

 
Figura A.45 – Dados estatísticos 

A explicação a seguir é para uma nova coluna, mas deve-se repeti-la para as 

outras colunas. Selecione a nova coluna, vá a barra de ferramenta: Edit > Fill > Formula > 

Dano_01 – 0,234621 (por exemplo) > OK. Nesse caso, a coluna será preenchida com o Z de 

Danos Materiais de 2001, procedimento que deve ser repetido para as demais colunas (Danos 

Materiais em 2002 e 2003, Atropelamentos em 2001, 2002 e 2003, Acidentes com Vitimas 
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em 2001, 2002 e 2003 e Acidentes Fatais em 2001, 2002 e 2003, Total do ano de 2001, 2002 

e 2003). 

O arquivo de matriz deve ser composto por cinco matrizes. Continuando os 

preenchimentos, é necessária a soma marginal da matriz de adjacência, o que pode ser obtido 

com o comando: Matrix > Settings..., que abre nova janela (Figura A.46). Em Options > 

Marginals, seleciona-se Sum, seguido de OK. 

 
Figura A.46 – Janela opção Matrix > Settings 

Ainda na matriz de adjacência opção: Matrix > Export Rows or Colums, abre a 

janela da Figura A.47. Seleciona-se Row Marginals, clica OK. Nomeie e salve. 

 
Figura A.47 – Janela opção Export rows or columns 

De volta ao arquivo de matrizes, na matriz Soma_marginal, selecione uma 

coluna clicando no topo da mesma (Figura A.48). O comando: Matrix > Import from 

Dataview abre a janela da Figura A.49. Preencha as lacunas conforme as setas indicativas, 

lembrando de selecionar a opção All para que todas as células sejam preenchidas (Figura 

A.50), caso contrário somente a coluna selecionada será preenchida. 
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Figura A.48 – Janela da seleção de coluna para preenchimento da matriz 

 
Figura A.49 – Janela de preenchimento da matriz 
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Figura A.50 – Matriz de soma marginal 

Selecione a matriz “Normalizada”, vá à barra de ferramentas: Matrix > Fill 

(Figura A.51) > Fill with formula – preencha as lacunas conforme a Figura A.52. O 

preenchimento da matriz é demorado por causa do processamento entre duas matrizes com 

grande quantidade de dados. 

 
Figura A.51 – Janela opção: Matrix > Fill 
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Figura A.52 – Janela opção Fill with formula 

 
Figura A.53 – Matriz Normalizada 

O preenchimento da quarta matriz depende dos dados do Dataview exportados 

para a matriz. Na matriz Z seleciona-se uma linha qualquer. A opção: Matrix > Import rows 

or columns, abre a janela da Figura A.54. Selecione: Range > (All rows), Import from > 

(nome do Dataview), Columns IDs > (ID), From > (nome da coluna Z desejada, p.ex., 

Z_dano_01) > OK (Figura A.55). 
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Figura A.54 – Janela opção Import rows or columns 

Neste procedimento é conveniente que a coluna importada do Dataview seja a 

última da listagem para facilitar o preenchimento. É por isso que foi sugerida anteriormente a 

criação das novas colunas uma a uma. Caso as novas colunas do Dataview tenham sido 

criadas todas numa única vez, vá à barra de ferramenta: Dataview > Modify Table > clique 

sobre a coluna a utilizar > Move Down movendo-a até que seja o último nome da lista. Este 

procedimento deve ser repetido todas as vezes que for preencher matrizes por meio de 

importação de dados do Dataview. 

 
Figura A.55 - Matriz Z 
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O preenchimento da quinta matriz é simples, é uma multiplicação de matrizes. 

Com o comando: Matrix > Fill > Fill with formula > (Normalizada x Z) > OK (Figura A.56). 

 
Figura A.56 – Matriz Wz 

Concluído o preenchimento das cinco matrizes, devem-se exportar os 

resultados para o Dataview. Para isso, na matriz Wz vá a barra de ferramenta: Matrix > 

Settings > Options > Marginals > Sum (Figura A.47). Sem selecionar qualquer linha ou 

coluna, vá a barra de ferramentas: Matrix > Export rows or columns > OK > Save As. 

 
Figura A.57 – Janela para exportar dados da matriz Wz 
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De volta ao Dataview de segmentos acrescente mais uma coluna. Faça um join 

entre o Dataview de segmentos e o Dataview resultante da soma marginal.  

No Dataview de segmentos acrescente novas colunas (Wz, parcela A e parcela 

B, por exemplo) através do comando Dataview > Modify Table > Add Field (coluna de 

números reais e com quatro casas decimais) > OK.  Selecione a nova coluna e com o comando 

Edit > Fill > Formula > Field List (escolha a coluna vinda da matriz) > OK. Em seguida 

desfaz-se o Join, conforme instruções anteriores. 

Próximo passo, selecione a coluna Parcela A, vá ao menu de ferramentas: Edit 

> Fill > Formula > Field List (coluna Z) x (coluna Wz) > OK. A seguir, repita a operação com 

a coluna Parcela B e no campo Field List, escolha (coluna Z) x (coluna Zt). 

Terminado o processamento, no menu de ferramenta, escolha: Dataview > 

Statistics, nomeie o arquivo e salve. 

 
Figura A.58 – Janela com os Dados Estatísticos 
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Na coluna Sum encontre os valores correspondentes às colunas Parcela A e 

Parcela B. Com uma operação simples divida a Parcela A pela B e encontra-se o valor do 

Índice I. 

A.6 Box Map 

Para a confecção dos Box Maps, acrescente nova coluna no Dataview de 

segmentos, selecione-a e preencha Edit > Fill > Formula: if (Z>0 and Wz>0) then 1 else if 

(Z<0 and Wz<0) then 2 else if (Z<0 and Wz>0) then 3 else if (Z>0 and Wz<0) then 4 else 0. 

O resultado dos Box Maps são as Figuras 5.1 a 5.18. 

O procedimento descrito até aqui deve ser executado para o Total de Acidentes 

e o Total de Acidentes com Severidade, lembrando que os valores dos acidentes com a UPS já 

foram computados no começo dos cálculos, quando do cálculo do Z. 

O Total de Acidentes com UPS em arcos e interseções difere na maneira de 

calcular os valores dos acidentes já que estes devem ser separados em arcos (quadra) e 

interseções (esquinas).  

A.7 Distribuição dos Acidentes entre esquinas e quadras 

Ative a camada de acidentes, é conveniente ativar um ano de cada vez. 

Classifique os acidentes pelo local do ocorrido, por exemplo, quando no endereço tiver além 

do nome de rua e número da casa, este acidente ocorreu no meio da quadra, quando tiver dois 

nomes de rua e/ou não apresentar qualquer número, então ocorreu em esquina. Isso se faz 

necessário para poder calcular a fração de acidente. 
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Para classificar, crie duas colunas, em uma delas preencha através do Edit > 

Fill > Formula > condicionando ao endereço do acidente. A outra coluna receberá a contagem 

do número de segmentos envolvidos no acidente. 

No mapa ative a camada dos Endpoints dos segmentos e faça um Buffer de dez 

metros ao redor dos Endpoints, salve. Vá ao menu de ferramenta: Dataview > Modify Table > 

Add Field > (acrescente e nomeie doze colunas: Acidentes Totais 2001, 2002, 2003, 

Acidentes tipo 1 em 2001, 2002, 2003, Acidentes tipo 4 em 2001, 2002, 2003, tipo 6 em 

2001, 2002, 2003, tipo 13 em 2001, 2002 e 2003) > OK 

 A seguir selecione uma coluna: Edit > Fill > Aggregate > From layers: 

acidentes, Include: total / parciais, Fill with: Count (Figura A.59) 

Ainda no Dataview do Buffer: Edit > Fill > Aggregate > From layers: links, 

Include: all features, Fill with: Count. Por ultimo: Edit > Fill > Formula > acidentes / links, 

com este último procedimento normaliza-se o número de acidentes. Repete-se este 

procedimento para cada ano e tipo de acidentes. 

 
 

Ao final, no Dataview de segmentos acrescenta-se uma coluna (conforme 

procedimento já descrito); seleciona-a, Edit > Fill > Aggregate > Sum, com isso é feito a 

contagem dos acidentes.  E assim cada ponto será um acidente, portanto uma fração de 

acidente já será o coeficiente de cálculo dos acidentes. 

Figura A.59  – Janela para contagem dos dados da camada de vias




